# Table of contents

## Chapter 1 - Introduction

- Welcome .................................................................................................................. 5
- New features in DxO Optics Pro 9........................................................................... 7
- DxO help and resources ......................................................................................... 8
- Versions .................................................................................................................. 8
- System requirements .............................................................................................. 8
- Registration, downloading, installation and activation ............................................ 9

## Chapter 2 - The Organize tab

- About the Organize tab .......................................................................................... 11
- The Organize tab interface ...................................................................................... 11
- The command bar ................................................................................................... 12
- The source browser ................................................................................................. 12
  - Browsing folders (default mode) .......................................................................... 13
  - Managing folders and files ................................................................................... 13
  - Managing projects ............................................................................................... 13
- The Image Browser .................................................................................................. 15
  - Image Browser (docked) ....................................................................................... 15
  - Image Browser (undocked) .................................................................................... 15
  - Image Browser command bar ................................................................................. 15
  - Image Browser information messages .................................................................. 16
- Sorting images ........................................................................................................... 16
- Filtering images ........................................................................................................ 17
- Thumbnail icons ........................................................................................................ 18
- DxO Optics Modules ................................................................................................. 19
  - Installing new DxO Optics Modules ...................................................................... 19
  - Managing DxO Optics Module .............................................................................. 20

## Chapter 3 - The Customize tab

- About the Customize tab ........................................................................................ 21
- About the workspace (general) .............................................................................. 21
- Managing palettes and workspaces ....................................................................... 22
  - Using and moving palettes .................................................................................... 22
  - Your workspace ..................................................................................................... 22
  - Creating a custom palette ...................................................................................... 22
  - Creating a custom workspace ............................................................................... 23
- Image analysis palettes ............................................................................................ 24
  - Move/Zoom palette ............................................................................................... 24
  - EXIF palette .......................................................................................................... 25
- Correction palettes .................................................................................................. 25
  - About correction palettes ..................................................................................... 25
  - Local help ............................................................................................................. 26
- Histogram ................................................................................................................ 26
- Essential Tools ........................................................................................................ 27
- Light and Color – Advanced ................................................................................... 39
- Detail and Geometry – Advanced ............................................................................ 43
- Optical Corrections ................................................................................................. 46
- DxO FilmPack .......................................................................................................... 50
- Presets ...................................................................................................................... 51
  - About DxO Optics Pro presets .............................................................................. 51
  - The different categories of available presets ......................................................... 52
  - Applying a preset ................................................................................................... 54
  - Creating a complete setting from current settings ............................................... 54
  - Managing presets with the Preset Editor ............................................................... 54
Welcome to DxO Optics Pro 9, whose powerful tools will help you enhance your photos quickly and automatically.

**We have tested your camera and lenses**

First let us introduce our company: DxO Labs is a high-technology firm that specializes in digital image processing. Our engineers publish papers in the most prestigious journals in the world. Thanks to this scientific and particularly mathematical foundation, we have been able to design DxO Optics Pro as a tool that aims not just to improve quality, but to achieve perfection — and more specifically, automatic perfection.

What makes DxO Optics Pro so special is that we test in our laboratories all of the equipment that you use. Each camera and lens spends several days in the hands of our technicians, who measure not only optical defects such as distortion, vignetting, and lens softness, but also the noise, colorimetry, and tone curves for each piece of equipment. They even analyze any in-camera processing that is applied to the images.

The result is a huge database that has no equivalent anywhere else in the world — the first pillar on which our exclusive quality is based. It is this database that gives DxO Optics Pro the information it needs about the camera and lens used to shoot a given image, along with the aperture, focal length, exposure time, etc. — to be able to calculate all of the necessary corrections: that this pixel needs to be brightened by x%; that that pixel needs to be moved by a particular distance in a particular direction; that yet another pixel needs its red channel adjusted, and so on. But all of these corrections require no effort on your part: the software downloads the profiles of your camera and lens all by itself, and then applies the necessary changes automatically.

**Our software analyzes each of your images individually**

Each photograph is unique — even photographs of the same subject under similar shooting conditions will differ from one another. One may contain a slightly overexposed area. The other might be too grainy because of noise in deep shadow. Yet a third photo might lack a bit of contrast. How can one handle all of these differences?
For most photo software developers, the answer is simple: they will provide you with a number of correction tools and then leave you to fix each of your photos one at a time. But this is not how DxO Optics Pro works. To our way of thinking, it is DxO Optics Pro's job to analyze each image and to determine if any corrections are necessary — and if so, to apply optimized corrections. After doing all this, the software submits the resulting images to you to judge — and to adjust any of the applied corrections according to your own taste and judgment.

**What DxO Optics Pro does to your images**

- If your original photo is in RAW format, DxO Optics Pro provides it with the best RAW converter ever designed. When transforming the RAW sensor data using the “demosaicing” process (which converts raw data from the sensor into red, green, and blue pixels), among other processes, DxO’s converter creates an image that is virtually free of artifacts.
- Without any need for direct intervention, DxO Optics Pro corrects optical defects — distortion, vignetting, lateral and longitudinal chromatic aberration, and lens softness — thanks to the high-level database of camera/lens characterizations built up in our laboratories over the years.
- DxO Optics Pro subtly and automatically retains highlights in RAW images while preventing them from being clipped, and even recovers certain details in areas that are already clipped. (We advise you to work in RAW whenever possible to take advantage of the greater latitude in processing and correcting your images.)
- Thanks to our laboratory measurements of each camera body, DxO Optics Pro includes unrivaled denoising tools that let you obtain high-quality images at the highest sensitivities.
- DxO Optics Pro offers a unique automatic correction of contrast and lighting in shadows, equivalent to a fill-in flash, for radically improving any high-contrast or backlit photos.
- DxO Optics Pro provides efficient tool for modifying an image’s color rendering such that you can make it seem like your image was taken with a different camera, or taken using analog film.
- DxO Optics Pro offers an exclusive tool for wide-angle shots to correct deformation of faces and bodies by using non-conventional (cylindrical or spherical) perspective methods.
- Finally and most importantly, the software performs nearly all of the corrections mentioned above automatically, while leaving you the ability to fine-tune or adapt the results to suit your taste.

**NOTE**

We use certain terms that are specific to DxO Optics Pro throughout this user guide, such as “preset,” and “virtual copy,” etc. These terms are defined in detail in the Glossary section of the appendix to this guide.

**About DxO FilmPack plug-in for DxO Optics Pro**

DxO FilmPack brings to digital photographs all the quality and emotion of Fine Art photography by combining precise analog film renderings with high-quality creative effects. Based on DxO Labs’ exclusive advanced calibration technologies, DxO FilmPack faithfully reproduces the characteristic colors, contrast, saturation, and grain of dozens of legendary analog films. Choose the film that suits you best: up to 26 black & white films and 36 color films are available to you to help reveal your artistic flair or to rediscover an old familiar style.

DxO FilmPack for Microsoft Windows and OS X comes in two editions – Essential and Expert – which differ in terms of the number of available film renderings and features. DxO Optics Pro contains a 31-day trial version of DxO FilmPack, which can be launched via the Help menu.

As a plug-in for DxO Optics Pro, DxO FilmPack is completely integrated and appears as a dedicated palette in the Customize tab to give you the best and most comfortable user experience — letting you treat an entire batch of images as part of a totally-reversible RAW workflow.

DxO FilmPack can be used as a standalone application and as a plug-in for Adobe Photoshop CS3, CS4 [32- & 64-bit], CS5 [32- & 64-bit], CS6 [32- & 64-bit], CC [32- & 64-bit], Adobe Photoshop Elements 9, 10 and 11, Adobe Photoshop Lightroom 3, 4, and 5, and Apple Aperture 3.
1.2. New features in DxO Optics Pro 9

**Breathtaking images, even at extremely high ISO**

DxO Optics Pro 9 introduces PRIME, a revolutionary noise reduction technology whose spectacular performance produces detailed and vividly-colored images even under the most extreme shooting conditions.

Thanks to PRIME (Probabilistic Raw IMage Enhancement) denoising technology, which analyzes the structure of RAW images in depth in order to differentiate between noise and fine details, DxO Optics Pro 9 offers a gain in image quality of up to one full stop over the best noise reduction algorithms currently on the market.

PRIME technology results in truly spectacular images: noise is suppressed, and textures, details, and color saturation are preserved, particularly in shadows, for a beautifully natural look.

For photographers who prefer to denoise their images immediately, DxO Optics Pro 9 still offers a newly-improved High-Quality “classic” denoising tool that produces finely-detailed renderings quickly, even at the highest sensitivities.

**Unrivaled highlight management and color rendering**

The exclusive DxO Smart Lighting feature optimizes the overall contrast of an image by intelligently adapting to its contents. This tool has been further improved in DxO Optics Pro 9, which now offers even more powerful highlight management: details that once were thought lost are revealed, even when the information is missing in the original RAW data, and colorimetric errors are minimized.

DxO Labs’ highly precise knowledge of the way each camera reproduces color allows DxO Optics Pro to emulate the rendering of any camera on RAW images. DxO Optics Pro 9 goes even further by proposing a new color rendering called “DxO Portrait,” which preserves skin tones and naturally-saturated colors.

**New visual presets**

DxO Optics Pro 9’s library of presets has been completely redesigned. Portrait, Landscape, Black & White, Single-shot HDR: the new DxO presets respond to different use cases that photographers frequently encounter, and are supplemented by “Atmospheres,” a new set of creative renderings.

A new visual presets window makes it easier for users choose which preset to apply to their images by letting them preview thumbnails of the rendering effects prior to application.

**New export tools**

DxO Optics Pro 9 simplifies its workflow by allowing photographers to go directly from customizing their images to using and sharing them. The “Export to Disk” feature lets users generate and save JPEG, TIFF, and DNG images in just a few clicks. The new “Export to Application” feature groups into a single transaction both processing and opening images in an external application, such as other DxO software products or other editors that specialize in photo retouching, panoramic shots, HDR, and cataloging.

Both the “Export to Facebook” and “Export to Flickr” functions use a new approach that allows you to publish your photos directly to your online social networks.

**New workflow with Adobe Lightroom**

In one click, transfer your RAW images from Lightroom to process them using DxO Optics Pro.

**Even more comfortable and productive**

The DxO Optics Pro interface has undergone another evolution, with a new workspace that highlights essential correction tools, optimizes vertical space, and reorganizes toolbars and palettes in an even more logical fashion. Further, it is now possible to access context-sensitive help directly in the correction palettes.
1.3. DxO help and resources

Find DxO help resources for DxO Optics Pro – tutorials, guide, webinars – on the DxO Academy webpage (http://www.dxo.com/intl/photography/tutorials). You can also access this webpage directly from DxO Optics Pro by selecting Help > DxO Academy.

1.4. Versions

DxO Optics Pro is available for Windows and OS X in two different versions, Standard and Elite, which are strictly identical in terms of tools and features. The only different is that the Elite version supports certain high-end camera models in addition to all of the cameras supported by the Standard version.

1.5. System requirements

For best results with DxO Optics Pro, your computer must meet the following minimum specifications:

**Microsoft Windows**
- **Operating system**: Microsoft Windows Vista [32-, 64-bit], Microsoft Windows 7 [32-, 64-bit], Microsoft Windows 8 [32-, 64-bit], Microsoft Windows 8.1 [32-, 64-bit].
- **Processor**: Intel Core® 2 Duo, AMD Athlon™ 64 X2 or higher [recommended: Intel® Core™ i5, AMD® Phenom™ II X4 or higher].
- **Disk space**: 2 GB minimum (6 GB recommended).
- **RAM**: 2 GB minimum (8 GB recommended).
- **Graphics card**: For GPU acceleration support:
  - Support for DirectX 9.0.c or higher.
  - 512 MB of video memory (VRAM) is recommended.
  For OpenCL acceleration support:
  - NVIDIA GeForce 460 or higher
  - ATI Radeon HD 58xx or higher

A 64-bit operating system with 8 GB of RAM is strongly recommended for processing RAW images larger than 24 Megapixels. A machine equipped with a 4-core processor is strongly recommended.

**OS X**
- **Operating system**: OS X 10.6 Snow Leopard, 10.7 Lion, 10.8 Mountain Lion, Mac 10.9 Mavericks.
- **Processor**: Mac Intel® only, 64-bits compatible [recommended: Intel® Core™ i5 or higher].
- **Disk space**: Minimum 2 GB (6 GB recommended).
- **RAM**: Minimum 2 GB (8 recommended)
- **Graphics card**: 512 MB of video memory (VRAM) is recommended to support GPU acceleration.

A 64-bit operating system with 4 GB of RAM and a machine equipped with 4-core processor are strongly recommended for processing RAW images larger than 24 Megapixels.
1.6. Registration, downloading, installation and activation

Important: You need an Internet connection to follow the steps described below.

Registration

You must register your license in order to activate your software. To do so, go to the DxO Labs website at http://www.dxo.com/CD and follow the registration procedure. If you do not have a DxO Labs customer account, please fill out the online form. If you already have a DxO Labs customer account, please sign in.

Downloading

Once you have registered your license, you will find important information in your DxO Labs customer account about your software, along with the download link for DxO Optics Pro. This procedure ensures that you will be installing the latest version of the software. Depending on your equipment, click on the WIN or MAC button to begin downloading the installer.

After the download is completed, double-click on the program icon that you just downloaded, and follow the steps in the installation procedure.

Installation

Microsoft Windows

1. Choose the installation language.
2. A “welcome” dialogue window will confirm that DxO Optics Pro installation has begun. Click on Next.
3. After accepting the license conditions, click on Next.
4. Choose where you want to install DxO Optics Pro.
5. Click on Install. The installation will begin and will take a few minutes to complete.

OSX

1. As soon as downloading has completed, double-click on the DxO_Optics_Pro9.dmg icon to decompress it and to launch the installation.
2. A window will open in which you will need to drag and drop the DxO Optics Pro 9 icon into the Applications folder. You can then launch DxO Optics Pro 9 from this folder.
3. When DxO Optics Pro 9 first opens, a window with an End-User License Agreement appears. To use DxO Optics Pro 9 software, you have to read and accept this contract. Click on Accept to continue.

Activation

1. Launch DxO Optics Pro.
2. A dialog box will appear. Enter (or cut and paste) your activation code in the appropriate field and click on the Activate button.
3. If you have not created your account, a message appears asking you to visit the page to create an account at the following link: www.dxo.com. Fill out the form and submit it. A message will tell you when your account has been created and your activation code will appear in your customer account. Return to the application and enter your activation code.
4. A message will inform you that DxO Optics Pro has been properly activated. Click on Ok. You can now start using your software.

Once the application is installed, you can use it for 31 days without having to enter an activation code. DxO Optics Pro will work without restriction during this time period. Beyond 31 days, the output images are then marked with a watermark “DxO Optics Pro 9 DEMO.” If you have not done so already, we recommend that you purchase an activation code as soon as possible.

NOTE

Your activation code allows you to activate the software on two different computers.
NOTE
Printing is deactivated once the DxO Optics Pro trial period (31 days) has ended. To reactivate this function, you will need to register and activate your license.

Uninstalling

Microsoft Windows
1. Click on Start > Programs > DxO Optics Pro 9 > Uninstall.
2. Follow the procedure for uninstalling.

OS X
1. Go into the Applications folder.
2. Drag and drop the DxO Optics Pro 9 icon into the trash can.
The Organize tab

2.1. About the Organize tab

On launch, DxO Optics Pro opens in the Organize tab. This first step lets you find and select the folder or project containing the images that you would like to process (either singly or as a batch).

2.2. The Organize tab interface

The Organize tab is composed of four principal sections or panes:

1. The Command bar lets you navigate through your file system, display your images, and apply presets.
2. The Source browser lets you navigate through folders or projects to locate the photos you want to work on.
3. The Image Browser displays, as thumbnails, the pictures in a selected folder or project.
4. The Viewer shows the selected image in the Image Browser.

NOTE

You can adjust the sizes of these four panes to suit your needs. They are delimited by two separator bars, one horizontal and one vertical, both indicated by central dots, or by a Microsoft Windows arrow, or by a OS X dot. Each bar can be moved at will, changing the relative size of each part of the screen.
2.3. The command bar

The command bar contains buttons and menus that let you navigate among the DxO Optics Pro tabs, determine the way in which your image will be displayed in the Viewer, and choose the level of zoom. You will also find a menu that will let you apply presets.

1. The tab selector, located above the command bar, lets you switch from one tab to the other.

2. Display modes:
   - **Compare**: displays one image at a time in the viewer and the corrected image preview. You can also use Ctrl+D (Microsoft Windows) or D (OS X) to toggle between before and after corrections (the reference image will continue to be displayed while you hold down the shortcut keys or mouse button).
   - **Select reference image** drop-down menu (Microsoft Windows): lets you select a reference image for comparison purposes; menu choices are As Shot (default), Output Image, and Virtual Copy.

3. **Dual image mode** (Microsoft Windows) lets you display an image before and after correction side-by-side.
   - **Select reference image** drop-down menu (OS X): lets you select a reference image for comparison purposes.

4. Display size:
   - **Zoom to fit** displays the entire image in available space in the Viewer.
   - **1:1** displays the image at 100% (1 image pixel = 1 screen pixel).
   - **Current zoom level** drop-down menu lets you change the zoom settings to predefined values or to enter your own zoom value.

5. **Apply preset** button lets you bring up a visual palette of available presets and apply them to your image.

2.4. The Source browser

The Source browser lets you browse through the contents of the folders on your computer and on peripheral devices, as well as through the projects you store in the projects database.
2.4.1. Browsing folders (default mode)

When you click on the Folders icon in the Source browser, you can explore the contents of your computer and its peripherals (including internal additional drives, external drives, CD-ROMs, DVDs, or memory cards. You can navigate through your volumes and folders to locate the images you want to process. The image thumbnails and names will appear in the Image Browser as you go. In OS X, the browsing operation is identical except that you will not see buttons for Folder and Project. Instead, they and their nested contents will appear in the same navigation tree.

TIP

You can hide or display the Source Browser by selecting Hide/Show Source Browser in the View window (both platforms) or by using the keyboard shortcut Ctrl+F10 (Microsoft Windows only).

2.4.2. Managing folders and files

When in the Folders view (Microsoft Windows), you can create a new folder by right-clicking on a folder and selecting the Create new folder option in the context menu (the context menu is also where you can rename folders). Creating a folder in DxO Optics Pro also creates it on your hard drive, which you can confirm by right-clicking on the new folder and choosing Open Windows Explorer. In OS X, you perform all the same folder-related operations in the Finder.

TIP

To add images to a folder or to move images from one folder to another in Microsoft Windows, select the images to move in the Image Browser, and then drag and drop them to the destination folder while holding down the Shift key. If you want to put copies of the images into a different folder, then drag and drop them while holding down the CTRL key. In OS X, simply select the images you want to add or move in the Image Browser and drag and drop them into the destination folder.

2.4.3. Managing projects

A project lets you group together photos from various origins. They may differ not only in terms of shooting date, camera type, lens, speed, aperture, etc. — they may also originate from very different storage environments: the normal computer file system, a hard disk, a CD-ROM, DVD, photo-card, or other medium.

TIP

You can also access your projects via File > Open a project or Recent locations (Microsoft Windows), or Open Project or Recent Projects (OS X).

In Microsoft Windows, click on the Projects button in the Source Browser. The pane will display an alphabetized list of existing projects (of course, this list will be empty when you first begin using DxO Optics Pro). When you click on a project, its contents will appear as thumbnails in the Image Browser.

In OS X, projects are found in the Source Browser navigation tree underneath the folders.
Creating or deleting a project

In **Microsoft Windows**, to create a project, click on the + button in the header. A new project will appear in the list, and you can rename it right away. Projects are always shown in alphabetical order, but you can rename a project anytime by clicking directly on its name or by right-clicking and selecting *Rename Project* in the context menu.

To delete a project, select it in the list and click on the icon - in the header, or right-click on the project and choose *Delete* in the context menu. A dialog box will pop-up and ask you if you are sure you want to delete the project.

In **OS X**, to add your first project, click on the arrow to the left in the Projects header in the Source Browser, then click on the + button in the command bar that appears on the bottom. A new project will appear that you can rename right away; then follow the steps described below.

Adding images to a project

To create a project with several photos, select the images in the **Image Browser**, then right-click and choose *Create a project from current selection* in the context menu (you can do this in either the Organize or Customize tab). For **Microsoft Windows**, you will automatically jump to the **Organize** tab in the Project browser, and a new project will be automatically added. You can name your Project by clicking on the default name (New Project #1). For **OS X**, a floating window appears in which you can name your project, which will then be added in the Projects section of the Source Browser in the Organize tab.

**TIP**

You can also automatically create a new project by dragging and dropping one or more photos into the **Image Browser** or the **Viewer** from Windows Explorer (Microsoft Windows) or from the Finder (OS X). In this case, a dialog box will prompt you to name the new project.

To add more photos to an existing Project, select them in the **Image Browser** (Ctrl/Cmd-click or Shift-click), right-click, and select *Add current selection to project* in the context menu, which will let you choose the desired destination project from a list of the projects you have already created. From there, you will be able to access the list of existing Projects and select the appropriate one in the menu. The **More projects** command (Windows only) displays the complete list of existing projects in a floating window.

**TIP**

Once a project is open, you can also drag and drop images into it from the Windows Explorer (PC) or from the Finder (Mac).

The *Create a project from current selection* and *Add current selection to project* commands are also available in the **Image** menu in both the **Organize** and **Customize** tabs.

The **Image Browser command bar** also shows, from left to right, the selected project name, the file name of the selected photo (Microsoft Windows only), the number of selected photos, and the number of photos in the project. You can add as many photos as you want to a project, and you can also assign the same photo to different projects.

**NOTE**

A photo added to multiple projects is not physically duplicated. If you add a photo to different projects, removing it from one project will not remove it from the other projects. Removing a photo from a project doesn’t remove it from the original folder or directory. If you modify or correct a photo which is part of many projects, the changes will affect this particular photo in all projects it belongs to. If you want to apply different settings or corrections to the same photo in different projects, create virtual copies of it.
2.5. The Image Browser

The Image Browser displays the contents of a folder or project selected in the Source Browser (left-hand pane). A given thumbnail selected in the Image Browser is displayed in the Viewer.

2.5.1. The Image Browser (docked)

Image thumbnails in the Image Browser are displayed horizontally, and you can navigate through them using the scroll bar, or with your input device (mouse scroll wheel, trackpad, etc.). You can adjust the size of the Image Browser by moving the line between it and the Viewer.

2.5.2. The Image Browser (undocked)

You may find it advantageous to undock the Image Browser, especially if you use a second screen.

- To detach the Image Browser, go to the View menu and select Undock Image Browser (keyboard shortcut Ctrl/Cmd+U).
- To reattach the Image Browser, go to the View menu and select Dock Image Browser (keyboard shortcut Ctrl/Cmd+U).

The undocked Image Browser appears as a floating window that you can position freely on your principal monitor (or on your second monitor if you have a dual display). Moving the Image Browser will increase the vertical size of the main display pane. The undocked Image Browser can be resized, and the scroll bar will be located on the right side. The navigation buttons are still available and you can set the size of the thumbnails with the slider located on the right side of the Image Browser command bar.

> TIP

While the Image Browser is undocked, it will display a slider in its command bar that will let you resize the thumbnails.

> TIP

If you can’t see the image resizing slider, enlarge the Image Browser window.

2.5.3. The Image Browser command bar

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Microsoft Windows**

1. Name of the folder or project in use, and the name of the selected image (Microsoft Windows only).

2. Sorting and filtering options:

   - Sorting images: Photos in the Image Browser can be classified using different criteria (more details in the “Sorting images” paragraph below) and displayed accordingly.

   - Filtering images: This button acts as a display filter (see the paragraph on “Filtering images” below).
**Navigation buttons** let you go forward or backwards when viewing images in a project or folder, and to go directly to the first or last images in a project or folder.

**Number of selected images/Total images in the project** or **folder** displayed in the Image Browser.

**Export progress button**: By default, this button displays a small progress bar. By clicking on the button, you can open the floating progress palette that contains the progress bar(s) and details of the export(s) in progress or completed.

**NOTE**

You will see the progress button and bar only after you have started an export.

**Print**: Launches the print module.

**Export to disk**: The drop-down menu immediately to the left of this button lets you export your images to your hard disk, to an external application of your choice, a Facebook album, or to a Flickr gallery.

**NOTE**

The **Export to disk** button and the window with associated export options replace the Process tab in previous versions of DxO Optics Pro. For more information, see chapter 4 below.

2.5.4 **Image Browser information messages**

When the Image Browser is empty, you will see a message explaining why there is no image or thumbnail visible:

- No image selected.
- No image in this folder meets your filtering criteria.
- This folder does not contain any images.

**NOTE**

These messages can apply to folders as well as to projects.

2.5.5 **Sorting images**

Sorting images works in the same way whether they are saved in a folder or gathered together in a project: you can choose the order in which they are displayed (from left to right) as thumbnails according to the following criteria found when you click on the **Choose the item sort order** button:

**Microsoft Windows**

- **File Name**: By the name of the file in alphanumeric order.
- **Image Addition Order**: By the order in which images were added to the project.
- **Format (RAW/RGB)**: Sorts and lists RAW and RGB images when in the same folder or project.
- **File Format**: By file extension (.JPG, .TIFF, .NEF, .CR2, etc.) in alphabetical order.
- **File Size**: By file size in MB.
- **Creation Date**: By shooting date, creation date, or change date; practical for finding the most recent images in a folder or project.
- **Image Size**: In pixels (height x width).
- **Camera body**: By camera model.
- **Lens**: By lens model.
- **Rank**: By number of stars (visible only if the option has been activated in **Edit > Preferences > Display**
- **ISO Speed**: By ISO sensitivity.
- **Virtual Copy Number** (Microsoft Windows only): Groups all virtual copies and originals in alphanumeric order (for example, all virtual copies marked no. 2 are grouped together, followed by those marked no. 3, etc.; the number 1 is reserved for originals).
- **Processing State** (Microsoft Windows only): By the 3 possible options (awaiting processing, error, processed) – only if this option has been activated in **DxO Edit > Preferences > Display**
OS X

- **File Name**: By the name of the file in alphanumeric order.
- **Image Addition Order**: By the order in which images were added to the project.
- **Format [RAW/RGB]**: Sorts and lists RAW and RGB images when in the same folder or project.
- **File Format**: By file extension (.JPG, .TIFF, .NEF, .CR2, etc.) in alphabetical order.
- **File Size**: By file size in MB.
- **Creation Date**: By shooting date, creation date, or change date; practical for finding the most recent images in a folder or project.
- **Image Size**: In pixels [height x width].
- **Camera body**: By camera model.
- **Lens**: By lens model.
- **Rank**: By number of stars (visible only if the option has been activated in DxO Optics Pro [menu] > Preferences > Thumbnails).
- **ISO Speed**: By ISO sensitivity.

**NOTE**

Images that are not displayed cannot be selected for correction or processing.

### 2.5.6. Filtering images

Filtering affects which thumbnails are displayed in the Image Browser: if you uncheck a characteristic in the list, any images with that characteristic will be invisible. Filters are organized into groups as follows:

**Microsoft Windows**

- **Types of images**: RAW, RGB (supported non-RAW images), and images generated by DxO Optics Pro.
- **Noise reduction**: Display images to be processed using Standard or PRIME denoising.
- **Processing Status**: Images that cannot be processed, images waiting for processing, processed images, images with processing errors.
- **Ranking***: By number of stars, from 0 to 5.
- **Reset**: Resets the filter to its default status [all options active].

**OS X**

- **Types of images**: RAW, RGB (supported non-RAW images), and images generated by DxO Optics Pro.
- **Status of Optics Module***: Availability of Module, Module ambiguity, no Module available, etc.
- **Processing status***: Images that cannot be processed, images waiting for processing, processed images, images with processing errors.
- **Ranking***: By number of stars, from 0 to 5.
- **ISO Speed**: Images to process with either High quality or PRIME denoising.
- **Reset**: Resets the filter to its default status [all options active].

*Displayed in the list only if activated in DxO Optics Pro [menu] > Preferences > Thumbnails > Icon display.

**NOTE**

The filter criteria **PRIME** and **High Quality** are based on the image correction parameters associated with the **Noise Reduction** palette in the Customize tab. However, images are filtered into the High Quality list if they have either undergone High correction or if noise has not been corrected.

**NOTE**

An active filter will still be active when the software is restarted.
2.5.7. **Thumbnail icons**

Each thumbnail displayed in the Image Browser can contain a large number of icons that can inform you about the particular characteristics of each photo.

![thumbnail_icons](image)

1. **Processing status** icons
   - These icons indicate the processing status of each image:
     - 🌟 Waiting to be processed (shown by default).
     - 📷 Processed image.
     - ✅ The image correction was changed after export (Microsoft Windows).
     - 🔴 Processing error.
     - ⛔️ Do not process this image.
     - ☹️ Cannot process. This may be due to the fact that the image is too small, or that it is in an unsupported format (as with DNG images from unsupported cameras, for example).
     - ⌛️ Image processing underway.

2. **DxO Optics Module status** icons
   - The following icons inform you about the status of the DxO Optics Module associated with each image:
     - 🚀 DxO Optics Module enabled and ready to use.
     - 🚧 DxO Optics Module not available.
     - 📦 DxO Optics Module available for downloading.
     - 🙄 DxO Optics Module ambiguity [in this case, you will need to click on the icon to display a dialog box that will allow you to resolve the ambiguity as when, for example, you have used two different lenses which have very similar characteristics].
     - 📕 DxO Optics Module ambiguity resolved.

3. **Processing authorization** icons. These icons are inactive by default, but can be activated via Preferences. They show which images: are to be processed (green), must not be processed (red), or require a decision about processing (orange, which is the default status). When processing begins, images with green and orange dots will be processed, whereas images with red lights will not be processed. If you have enabled these icons, you can change the status of an image by right-clicking on its thumbnail in the Image Browser and selecting Allow processing in the context menu.

4. **Delete (recycle bin) icon**. Let's you delete images from your hard drive or remove them from a project.

5. **File name**. The file name is displayed by default along with a standard extension (JPEG, TIFF, etc.) or a proprietary extension (e.g., CR2 for images from Canon cameras).

6. **Virtual copy ID number**. Displays the sequence number (1, 2, 3, ..., etc.) for virtual copies, with number 1 always reserved for the original image.

7. **Ranking**. You can grade or rank to your images by assigning a number of stars (from 0 to 5) to each one; you can then use these rankings to filter your images.
8 **PRIME** badge. Indicates if the image is to be processed using PRIME noise reduction when exported.

9 **Missing information** icon (OS X only). This icon is hidden by default. It indicates that the information about focal length or focusing distance is inaccurate or was not properly recorded in the EXIF metadata. In this case, DxO Optics Pro will automatically set the focus distance to infinity and the focal length will be based upon EXIF data. Also, the **Focal distance** and **Focusing distance** sliders will automatically appear in the **Optical Corrections** palette, so if you have more precise information, you can adjust the sliders manually.

**NOTE**

You can display or hide icons or have them appear only during mouseover. To do so, go to: **Edit > Preferences > Display > Image Browser section** (Microsoft Windows) or **DxO Optics Pro > Preferences > Thumbnails > Icon display** (OS X). Certain icons are deactivated by default.

**2.6. DxO Optics Modules**

DxO Optics Pro provides automatic installation of the DxO Optics Modules that correspond to the equipment that you use. Two dialogue windows help you manage your DxO Optics Modules.

**NOTE**

You must have an active Internet connection to look for and install DxO Optics Modules while using DxO Optics Pro. You can also manually download Optics Modules from this webpage: [http://www.dxo.com/intl/photo/dxo_optics_pro/manual_download](http://www.dxo.com/intl/photo/dxo_optics_pro/manual_download)

**2.6.1. Installing new DxO Optics Modules**

To install DxO Optics Modules, go to **DxO Optics Modules > Download new DxO Optics Modules** (Microsoft Windows) or **DxO Optics Modules > Manage DxO Optics Modules** (OS X).

The DxO Optics Module installer or manage window offers you a list of cameras arranged by brand in alphabetical order. Under Microsoft Windows, you can display the complete list, or you can select a particular manufacturer from the **Brand** drop-down menu.

To download additional DxO Optics Modules, proceed as follows:

**Microsoft Windows**

1. Use the corresponding checkboxes to select one or more camera models.
2. Click on **Next**.
3. Use the corresponding checkboxes to select one or more lens models (the availability status of the relevant Optics Modules will be clearly indicated).
4. Click on **Next**.
5. The window will display a summary of the DxO Optics Module[s] for the camera/lens combination[s] you have chosen.
6. Click on **Next**.
7. The selected Optics Module[s] is/are downloaded and installed.
8. A dialogue box confirms the installation.
9. Click on **OK** to close the Optics Modules installer.

**OS X**

1. Click on the arrow to the left of a manufacturer’s name to select the brand, then click on the arrow to the right of the appropriate camera model.
2. Select a camera - lens combination from the list by clicking on **Download**.
3. The corresponding Optics Module is downloaded and automatically installed.
4. Repeat the same steps to install another Optics Module.
5. Click on **Close** to return to the main DxO Optics Pro interface.
2.6.2. Managing DxO Optics Modules

**Microsoft Windows**

The **DxO Optics Modules** window displays all of the Optics Modules installed on your computer. To display this window, go to the **DxO Optics Modules > Installed DxO Optics Modules** menu. You can also filter the list so as to see only those models that need to be updated or which are not yet supported.

To download an Optics Module again, select it in the list and then click on **Download** in order to open the **Install new modules** window.

You can delete an Optics Module in the same manner by clicking on **Remove**. A dialogue box will prompt you to confirm that you want to delete the Optics Module.

**OS X**

The **Manage DxO Optics Modules** window lets you display all of the DxO Optics Modules installed on your computer when you check the **Show only installed DxO Optics Modules** box in the lower left corner.

To install additional DxO Optics Modules, uncheck the **Show only installed DxO Optics Modules** box, and follow the steps in section 2.6.1 above (OS X).

To delete a DxO Optics Module from your computer, find it in the list and click on the corresponding **Remove** button.

---

**NOTE**

A DxO Optics Module used during an ongoing work session cannot be uninstalled. In order to do so, you will need to restart DxO Optics Pro and go to the **Manage DxO Optics Modules** window before you load any images.
The Customize tab

3.1. About the Customize tab

The **Customize** tab is the second tab in the DxO Optics Pro 9 interface. This is where you correct your images.

The Customize tab is divided into four parts:

1. The **command bar**, similar to that for the **Organize** tab, lets you control how your images will be displayed, and contains a number of other tools that we will describe below.

2. The **palettes** contain all the correction tools. You can detach and move the palettes around as you wish (see sections 3.3.1 and 3.3.4 below).

3. The **Viewer** is the central window in the application, and displays one image at a time (which you select in the Image Browser). It allows you to see the effects of the corrections you make with the various tools. You can also display both the original and the corrected images either one on top of the other, or side-by-side.

4. The **Image Browser**, available in both tabs, displays the contents of a folder or project as thumbnails.

3.2. About workspaces (general)

When you open DxO Optics Pro 9, all of the correction palettes appear in the right-hand column, but only the new **Essential Tools** palette is expanded, along with a limited number of its component palettes. These tools let you perform the most important corrections. Of course, you have full access to all available palettes; all you need to do is expand them by clicking on their title bars to access all of their tools.

Certain parts of workspaces cannot be modified, such as the command bar and the viewer. However, you can change the arrangement of the palettes and how the tools are grouped. You can not only decide what palettes should be displayed or hidden, but you can detach them and place them anywhere on your screen. You can create, save, change, and delete any custom workspace.
3.3. Managing palettes and workspaces

3.3.1. Using and moving palettes

Palettes are containers that group together tools that have a particular purpose in common. For example, the Essential Tools palette includes tools for correcting white balance, exposure, contrast, etc. — which are all required for basic image enhancement.

**TIP**

You can hide or display a palette either by clicking on its title bar (Microsoft Windows only) or on the arrow on the left side of the title bar (both platforms).

By default, correction palettes are anchored in the right-hand column, and the image analysis, EXIF, and presets palettes are anchored on the left. Any palette can be detached and placed anywhere on the screen. To detach a palette, simply drag it by its title bar to the desired location. To close a palette (that is, to no longer have it displayed in the workspace), click on the X in its title bar. (You can add any closed menu again by selecting it in the Microsoft Windows Palettes menu, or in the OS X View > Palettes menu.)

All of these operations can also be performed by using the drop-down menu that is found in the title bar of each palette. This menu lets you open and close the palette; anchor it in the left- or right-hand column; move it to wherever you want on your screen; and also change its order in the column where it is anchored.

It is also possible to anchor all the palettes in one single column to the left or the right of the image in order to provide more space to display the image.

**TIP**

To have even more space to work on your image, you can temporarily hide all of the palettes. For Microsoft Windows, go to the Palettes menu and select Hide/Display all palettes, or press the F9 function key; for OS X, press the Tab key.

3.3.2. Your workspace

When you use DxO Optics Pro for the first time, the workspace displays only the palettes and palettes that are essential for processing images:

- **Histogram**: Displays the light distribution for each of the RGB channels and the Luminance.
- **Essential tools** includes all of the basic correction tools: White Balance, Exposure Compensation, DxO Smart Lighting, Contrast, Color accentuation, Selective tone, Noise reduction, Horizon/Perspective, and Crop.
- The other palettes containing advanced settings are rolled up by default: Light and Color – Advanced, Detail and Geometry – Advanced, and Optical Corrections.

**NOTE**

If DxO FilmPack is installed on your computer, you will see the DxO FilmPack palette in the workspace as well. It is expanded by default.

3.3.3. Creating a custom palette

It is very easy to create your own custom palette. Just follow these steps:

**Microsoft Windows**

1. Open the menu Palettes > Create user palette.
2. Enter a name in the My palette floating window.
3. After you click on OK, your new palette will appear on the right, underneath the other palettes.
4. At this point your new palette is empty, but you will see a message prompting you to drag and drop your favorite correction tools into it.
5. As soon as you have finished populating the new palette with the tools you want to use for your corrections, you can close all of the other palettes.

**OS X**

1. Open the **View** menu and then go to **Palette > New palette**.
2. Enter a name in the **New palette** floating window.
3. After you click on **OK**, your new palette will appear as a floating window in the application window.
4. To add palettes and their associated tools, click on the icon at the extreme right in the title bar of your new palette and then select each tool you want to use from the list one at a time. (If you want to remove a tool or palette from your custom palette, simply click on the top-right icon again and uncheck the tool in the list.)
5. As soon as you have finished, you can anchor the palette in either the left or the right column in whatever order your wish.

### 3.3.4. Creating a custom workspace

You can create your own custom workspace(s) in DxO Optics Pro, in which you can add standard as well as your custom palettes as desired. To create a workspace:

1. Click on the X on the left in the title bar of the palettes that you do not want to use in your new workspace.
2. If needed, follow the procedure in the preceding section for creating new palettes.
3. To save your new workspace:
   - Open the **Workspace** menu and then select **Save Workspace** (Microsoft Windows).
   - Open the **View** menu and then select **Workspaces > Save Workspace** (OS X).
4. Enter a name for your custom workspace in the **Save Workspace** floating window.
5. Click on **Save**.

![The Palettes drop-down menu (Microsoft Windows)](image)
Your custom workspace will be available:
- In the **Workspaces** menu (Microsoft Windows).
- In the **View > Workspaces** menu (OS X).

When you quit from DxO Optics Pro, the last workspace you have selected will be the workspace displayed upon relaunching.

To delete a custom workspace:
- Select the workspace you want to delete in the **Workspaces** menu, and then select **Delete Workspace**. A dialog box will prompt you to confirm your decision (Microsoft Windows).
- Open the **View** menu and go to **Workspaces**. Select the workspace you want to delete and then choose **Delete Workspace** from the menu. A dialog box will prompt you to confirm your decision (OS X).

**NOTE**
You cannot delete the **DxO Standard** workspace.

### 3.4. Image analysis palettes

The **Customize** tab’s palettes are found on both sides of the **Viewer**, with correction palettes found on the right, and image analysis palettes (discussed immediately below) on the left.

#### 3.4.1. Move/Zoom palette

![Move/Zoom palette](image)

The **Move/Zoom** palette helps you navigate in the image displayed in the Viewer, and to analyze it in deep detail by zooming in. After zooming in on the image, you can use the white-bordered field in the left-side palette thumbnail view to move around in the image in the Viewer. The commands in the palette are identical to the ones found in the **Customize** tab command bar, except for the zoom slider (see the note below):

- The **Zoom-to-fit** button lets you expand the image to fill all the available screen area.
- The **1:1** button displays the image at 100% (that is, 1 image pixel = 1 screen pixel).
- The **drop-down menu** (Microsoft Windows) lets you choose from among the most common zoom settings (25 to 400%). You can also enter a custom value or increase or decrease the zoom value by clicking on the respective arrows (OS X).
- The **slider** (display scales from 2% to 1600%) lets you zoom in or out quickly.

**TIP**
You can quickly and easily zoom in and out of your image by using your (Microsoft Windows) mouse wheel or (OS X) by either holding down the Command key while using your mouse wheel or the equivalent Magic Mouse® gesture, or by using the pinch-zoom gestures on your trackpad.
3.4.2 EXIF palette

The EXIF information palette (Microsoft Windows on the left, OS X on the right) contains unchangeable image property information, followed by the EXIF editor, where you can enter author and copyright information.

Image properties

The list of image properties shows the information recorded as metadata by your camera in the header of your image file. This information cannot be altered and will be saved “as is” when you create a corrected copy of your image. The list of recorded information includes the camera model and make, the size of the image in pixels, the shooting date and time, the exposure program or mode, the ISO speed, the exposure speed (shutter), the exposure bias (compensation), whether the flash was fired, the metering mode, the lens model, the focal length, and the aperture.

EXIF Editor

The EXIF editor lets you add author and copyright information to the output image EXIF data.

**NOTE**

The unchangeable image properties and the editable Author and Copyright fields are grouped together in a single section in the OS X EXIF Editor.

**NOTE**

To protect your assets, we recommend that you add your name and copyright information to all your images before you publish or distribute them.

3.5. Correction palettes

3.5.1. About correction palettes

All of DxO Optics Pro’s correction tools, as well as the histogram, are available in DxO Standard workspace, grouped into five palettes:

- **Histogram**: Displays the light distribution in the RGB channels and Luminance.
- **Essential Tools**: Groups together the basic correction tools such as white balance, exposure compensation, DxO Smart Lighting, contrast, color accentuation, selective tone, noise, and crop.
• **Light and Color – Advanced**: Includes more specialized tone and color tools such as color rendering, style – toning, tone curve, and HSL color correction.

• **Detail and Geometry – Advanced**: Contains manually-adjustable tools for accentuating sharpness, and for handling moiré and dust, as well as for correcting volume deformation.

• **Optical Corrections**: Lets you correct the inherent flaws in lenses such as distortion, vignetting, chromatic aberrations, and lens softness. (Most of these problems are automatically corrected if the equipment you use is supported by a DxO Optics Module.)

Finally, if DxO FilmPack is installed on your computer, a sixth palette, called **DxO FilmPack**, will appear in whatever workspace you are working in.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certain palettes contain advanced tools that are hidden by default. To display or to hide them, click on the Advanced settings label (Microsoft Windows) or on the small + (or –) symbol in the lower right-hand corner of the palette (OS X).</td>
</tr>
</tbody>
</table>

### 3.5.2. Local Help

Each correction palette also features a local help system which you can access by clicking on the small question mark symbol in its upper right-hand corner. The help text will appear below the tools in the palette, and explains how each tool functions. You can hide this text by clicking on the question mark again.

### 3.5.3. Histogram palette

**About the histogram**

The histogram is the best tool to determine how a picture has been exposed, in order to help you to correct it properly. Basically, a histogram is a chart that shows the number of pixels for each level of luminance. The taller each vertical line, the more pixels with that value in the image. When the peaks are mostly located on the left side, it is a dark image. When they are mostly on the right side, the image is bright. When the vertical lines are spread from the left to the right, with a bump in the middle (for the midtones), the photo is balanced, and the full dynamic range is covered.

**RGB and L channels**

The DxO histogram tool calculates the brightness values for each color channel, and displays them all together on the same chart. However, you can also display the values per channel, as your camera does, by clicking on one of the buttons located on the right side of the chart:

- **RGB**: Displays all the channels together (RGB and Luminance).
- **R, G, or B**: Displays the Red, Green or Blue channels accordingly.
- **L**: Displays the global Luminance channel

When you mouse over the image, the histogram palette shows the RGB values for that portion of the image, on a 0 to 255 scale, and the actual color is shown in a patch. This is very useful for determining which channel is dominant and thus helps to detect colorcasts.
Clipping

When a luminance level goes below the left end of the histogram – the so-called black point, or above the right end – the white point, it will be constrained to pure black or pure white. Pixels in this position, or close to it, are said to be “clipped.” This situation can occur if the scene contains very dark areas, and if you expose for the bright tones: in that case, the dark tones will be clipped. Conversely, if the scene contains very bright areas and you expose for the mid or dark tones, the highlights will be blown out, and all the relevant details may be lost. The Histogram palette offers two clipping visualization tools, both located below the histogram chart:

- **Shadow clipping:** Clicking on the icon will display, in false colors, the zones where no (or only some) information is left in the dark area’s color channels.

- **Highlight clipping:** Clicking on this icon displays clipped or close-to-clipped bright areas. When all three color channels have reached their maximum values, the corresponding clipped bright zone is displayed as a false black on the image. When there is some information left in one of the color channels, the affected zone is displayed in other false colors.

![Clipping of highlights is visible as false colors in the right-hand image](image)

**TIP**

While it is important to correct burned highlights in order to recover clipped image details, it doesn’t make sense to try to recover very bright areas such as light sources (sun, bulbs, and lamps) or reflections (bare metal or glass surfaces).

3.5.4. Essential Tools palette

The Essential Tools palette contains the principal tools required for processing your images, and includes tools for correcting white balance, luminance, contrast, tone, colors, noise, horizon, and cropping. Advanced tools in the palettes collapsed by default will be discussed later in this guide.
White Balance

Regardless of its origin (artificial or natural), light usually appears white to our eyes. It is, however, nothing of the sort. Even daylight can contain strong blue dominants, particularly in shadows or when the sky is overcast. On the other end of the spectrum, incandescent bulbs have a yellow cast, while fluorescent lights produce complex green casts. Adjusting white balance serves to correct these undesirable light dominants.

The White Balance palette (Microsoft Windows)

Setting availability depends on the file type:

- For a **RAW** file, the white balance has yet to be established, and you can use any of the available tools in the palette.
- For a **TIFF** or **JPEG** file, the white balance has already been performed by in-camera processing (JPEGs), or by another software or image editor (TIFFs). Consequently, you are limited to using just the **Pick Color** eyedropper and the **Temperature** slider to adjust the White Balance correction.

**NOTE**

When you select a RAW file or a RGB file (JPEG or TIFF) in the Image Browser, the **White Balance** palette automatically adapts accordingly.

Using pre-established settings (RAW files only)

The drop-down Setting menu contains a certain number of settings that cover most known light sources, ranging from daylight, cloudy, or shade to tungsten, different types of fluorescent, or industrial (sodium, mercury) lights.

The **As Shot** setting is selected by default: in this case, DxO Optics Pro shows you the image white balance as shot by the camera. The **Manual or Custom** option automatically displays as soon as you perform the white balance using the **Color temperature** and **Tint** sliders (see below).

**NOTE**

The white balance is the only in-camera setting that DxO Optics Pro takes into account.

Using the color picker eyedropper (RAW or RGB files)

To use the color picker, choose an area that is as close as possible to neutral (light) grey on your image. Click on the eyedropper icon. The screen will display two images in side-by-side comparison mode. The left image is where you will use the color-picker, and the right image will show the correction preview.

**TIP**

Zoom in on the image to facilitate picking a neutral area, which can be very small.
White balance Radius slider

The **Radius** slider at the bottom of the Viewer lets you set the size of the sample area.

**TIP**

For images taken at high ISO speeds, we recommend increasing the **Radius** slider value to 10, to reduce pointing errors due to possible noisy patches.

**Fine-tuning the white balance of a RAW file**

However you choose to initially correct your images for white balance — via pre-established settings or the eyedropper, you can fine-tune the corrections using the **Color temperature** and **Tint** sliders. The **Color temperature** slider has a range of 2,000 °K to 20,000 °K, and can often be combined with the Tint slider to remove residual colorcasts.

**NOTE**

In all cases, choosing As Shot in the drop-down menu lets you safely revert to the settings provided by the image EXIF data.

**Fine-tuning white balance for a RGB file (TIFF or JPEG)**

When you select a JPEG or TIFF file in the Image Browser to set the white balance, the RAW white balance palette changes automatically to the RGB white balance palette, in which a simplified **Color temperature** slider is available in addition to the color picker. Strictly speaking, it is not possible nor recommended to set the white balance for a JPEG or TIFF file, since the white balance has already been established by in-camera processing. Therefore, any modification in one tonal range will produce imbalances in other tonal ranges: if we correct the midtone greys, then highlight greys or low-key greys will inevitably suffer a slight colored hue. You can use either the color picker (eyedropper — see above) or a dedicated slider, both available in the advanced settings (OS X), to move from cooler [blue] tones to warmer [yellow] tones and vice-versa.

**TIP**

To reset slider adjustments, double-click on the slider. For both RAW or RGB files, it is not always necessary to look for perfect white balance. Keep in mind the atmosphere of the scene you have photographed, and try to adjust the settings to maintain that atmosphere.
**Exposure Compensation**

**About Exposure Compensation**

The image on the left is overexposed globally, with burnt areas in the background. The image on the right shows the result achieved with the "Center-Weighted Average" in the Exposure Compensation palette.

Exposure Compensation adjusts the image exposure level— that is, it increases or reduces the brightness of each pixel in the image. Since a photographic system can capture only a fraction of the tonal range in the real world, most photos will have under- or over-exposed zones — or both at the same time.

Overexposure presents the biggest problem in digital photography, since the camera sensor cannot cope with brightness above a certain level and returns all-white pixels. The Exposure compensation tool can often recover information in these areas that have been incorrectly exposed, particularly with respect to RAW images, whose color channels generally retain some information even for burned areas. With JPEG images, which have already undergone a series of in-camera processes relative to each RGB channel, however, highlights that are lost are gone for good.

**Correcting a RAW file**

There are three automatic correction modes for priority highlight recovery: slight, medium, and strong (Microsoft Windows).

The Correction drop-down menu, specific to RAW formal images, proposes five automatic correction modes and one manual option:

- The Smart option: Depending on the image, highlights are recovered or the exposure is increased to set the white point.
- The Center-weighted average option: Optimizes the correction process (exposure adjustment) on the center of the image.
- Highlight Priority automatic mode deal with highlights, with three levels of recovery: slight, medium, and strong. Whichever correction you choose, be sure to verify the results in the histogram.

Manual exposure compensation requires the use of the Exposure slider, which has a range going from –4 Ev to +4 Ev (1 Ev, or “exposure value,” is the equivalent of one f-stop). Moving the slider to the right brightens the image, while moving to the left darkens it.
Choosing one of the automatic exposure options can speed up your workflow by providing custom settings for many types of shooting situations: usually, for example, the “slight” correction is enough for a normally-contrasted image.

**Correcting a JPEG or TIFF file**

By default, the **Smart** mode is active, but you can modify or fine-tune the settings manually with the **Intensity** slider that adjusts the exposure from −4 Ev to +4 Ev.

**TIP**

Correcting a JPEG or TIFF file

By default, the **Smart** mode is active, but you can modify or fine-tune the settings manually with the **Intensity** slider that adjusts the exposure from −4 Ev to +4 Ev.

Move the slider in small steps while monitoring the changes on the histogram, with the highlight zone visibility button (below the histogram on the left) activated so you can see if the exposure has been increased too much [some clipped zones appear] or not reduced enough [clipping still visible].

**DxO Smart Lighting**

**About DxO Smart Lighting**

*Backlit subjects are a typical case that calls for DxO Smart Lighting correction. Here, because of the very strong contrast, a high level of correction has been applied to open the shadows – as if a fill-in flash had been used*

Ordinarily, image corrections are applied to the whole photograph: when you modify the brightness or the contrast, you make the whole image brighter, darker, and more or less contrasted. The aim of the **DxO Smart Lighting** correction is to alter the local lighting in terms of brightness and contrast, increasing or reducing the contrast only where needed, such as in:

* Images with areas that are backlit.
* Images with a contrast range markedly higher than a camera can handle, especially images with very dark areas.
* Images that were accidentally underexposed, generally short on contrast, or lacking a flash fill-in.

**DxO Smart Lighting: Basic settings**

*The Auto mode of DxO Smart Lighting has three levels, which are sufficient for most photos (Microsoft Windows)*
As with many of our tools, DxO Smart Lighting is in Automatic mode by default: the software analyzes the image, identifies the areas that need correction, and applies the corrections. Two kinds of adjustments are available, together or independently:

- The first is a drop-down menu that lets you modify the intensity of the correction by choosing among four different levels: strong, medium, slight (default setting), and custom.
- The Intensity slider is set at the value assigned to the chosen automatic correction mode: 50 for Slight (default setting), 100 for Medium, and 150 for Strong. You can modify these slider settings, in which case the drop-down menu will display Custom mode.

DxO Optics Pro 7 mode
If you choose DxO Optics Pro 7 from the drop-down menu, the DxO Smart Lighting palette and its tools will automatically revert to the same interface and operation that you used in this earlier version.

**NOTE**
For more information about this earlier version of DxO Smart Lighting, see the DxO Optics Pro 7 User Guide, pages 37–41 [http://www.dxo.com/intl/photo/support].

What settings should you use with DxO Smart Lighting?

**DxO Smart Lighting** is probably the most complex of our corrections. It has a global and a local effect on the image – affecting the whole picture and local details – and has a strong influence on contrast and brightness. Such a complex correction can only be learned by practice. However, you will quickly see for yourself how effective DxO Smart Lighting is, even on difficult images.

First, generally speaking, DxO Smart Lighting changes bright images only slightly, but has a stronger effect on darker images. It has little effect on highlights, unlike Exposure Compensation. Second, you should stick with the three automatic correction modes as much as possible, as they can cope with most situations, and then fine-tune with the Intensity slider afterwards. If you need to go further and do additional corrections and fine-tuning, you can use the tools in the Selective tone palette or go to the Light and Color – Advanced palette and use the Tone Curve, if necessary.

**Contrast**

![Contrast palette (Microsoft Windows)](image)

**Contrast**
This tool controls the overall contrast of the image. DxO Optics Pro corrects for contrast using a classic S-shaped tone curve: shadows and highlights are compressed and mid-tones are expanded. The correction is activated by a slider with values ranging from −100 to +100.

**NOTE**
Be aware that this global contrast correction can strongly interfere with the Tone Curve correction.

**Microcontrast**

Microcontrast is sometimes referred to as “local contrast.” This slider controls the contrast of small homogeneous regions that have been delimited by the program. Enhancing the microcontrast gives results that can look somewhat similar to sharpening, without the pitfalls of the sharpening process (e.g., white artifacts along the edges when the settings are too strong). Local contrast correction enhances the details in the image, but produces very subtle results that you can only see with a high degree of magnification. It works very well in landscape, architectural, or industrial photography, but avoid it if you are shooting portraits of people, as it can reveal unflattering skin details.
DxO Optics Pro 9’s Microcontrast slider is much more powerful than in previous versions. This means that while the slider range still can be set anywhere from –100 to +100, a setting of 50 is now the equivalent of a setting of 100 in the older versions.

We recommend that you avoid using too much local contrast, especially when combined with the Unsharp Mask correction found in the Detail and Geometry – Advanced palette.

**Color accentuation**

The **Color accentuation** palette contains two sliders that enhance colors in very different ways: **Saturation** and **Vibrancy**.

**Vibrancy**

Compared to the **Saturation** slider, which reinforces all colors, the **Vibrancy** slider operates in a much more subtle way, taking into account the colors already present in the image. It can be defined as a “smart” color saturation setting. The range is from –100 to 100, and the default setting is 0. When the slider has a positive value, vibrancy increases the overall saturation, but with some very particular behaviors:

- Skin tones are protected to avoid red faces.
- Blue sky tone saturation is increased and slightly darkened than for the rest of the colors in the image, to give greater presence and depth to the sky.
- Tones already close to gray are not affected, to avoid a change of color balance.

When the slider has a negative value, the overall saturation level decreases, with the following restrictions:

- Desaturation never goes down to zero (i.e., a black and white image), unlike the most radical HSL corrections.
- Desaturation is more pronounced in the reds, which is useful for “rescuing” photos in which the faces are too red, and for making skin tones more natural.

**Saturation**

The **Saturation** slider is easy to understand: it increases the entire image color saturation if you move it to the right, and decreases it if you move it to the left, ultimately converting the image to gray levels when you reach a value of –100. The default setting is 0.

Beware of undesirable results if you combine a strong **Vibrancy** correction with an excessive level of **Saturation**.
Selective tone

The Selective tone palette (Microsoft Windows)

The Selective tone palette is a very intuitive and precise way to control and adjust the brightness of well-defined tonal ranges in an image:

- **Highlights**: This slider is designed to recover information and details in the brightest parts of the image (e.g., skies with bright clouds, the outside seen through an interior window panel).
- **Midtones**: This slider controls the brightness of the midtones, which are the levels located in the middle of the histogram.
- **Shadows**: Use this slider to lighten the shadows and dark areas of the image.
- **Blacks**: This slider lets you set the black point (left end of the histogram) in your image. To the left, the slider progressively changes the dark areas to solid black and, to the right, progressively lifts the black levels and makes them brighter (the histogram left end will move to the right, leaving no image data in the blacks).

**NOTE**

The Selective tone sliders can drastically change the contrast of your pictures. Use them in moderation and check your histogram to avoid clipping.

Noise Reduction

Noise in digital photography

All digital cameras suffer from noise to a certain degree. Noise is characterized by grain (luminance noise) and random color pixels (color noise). Noise is much more of a problem in the shadows (where the luminance signal is low) than in highlights. Noise is aggravated at high sensitivities (high ISOs) that basically amplify the image signal and thus amplify the noise along with it.
The **Noise Reduction** palette displays two **Quality** buttons which correspond to two different processing algorithms:

- **High**, which corrects noise rapidly and efficiently, with pleasing results for most photo uses.
- **PRIME**, which analyzes your image in depth to discern between noise and fine details. This processing results in image quality that is far higher than usual: details and saturation are perfectly preserved, but at the price of much slower execution (performed in the background).

The higher the ISO sensitivity, the more visible the difference in processing quality. As a general rule, the difference starts becoming more and more pronounced from ISO 1600 and higher, although this can depend on the kind of camera you use for any given image.

You can also use **PRIME** for images taken at lower sensitivities with very dark areas in which considerable noise tends to be present. Traditional noise correction noise in shadows has an impact on color saturation, so here, too, **PRIME** can make a big difference.

**NOTE**

**PRIME** can only be used with RAW files. **PRIME** requires considerable processing power and time: it will take several minutes to correct a 20 Mpix RAW file, depending on how powerful your computer is.

**Processing preview**

The effect of **PRIME** processing can be previewed in the **Magnifier** window in the **Noise Reduction** palette for a selected area in the image 150 x 150 pixels in size.

**NOTE**

When you choose **PRIME**, a barred-eye icon will appear next to the Noise Reduction palette name, indicating that the correction cannot be seen in the Viewer.

To select a particular area in your image to preview, click on **Magnifier center** near the upper right corner of the palette. This will activate the Magnifier by placing a dotted-line rectangle in the image in the Viewer. You can move this rectangle wherever you wish within the image. You will see a small circular icon in the Magnifier window until **PRIME** has finished processing the area you have selected.

The definitive application of the **PRIME** correction to the entire image occurs only upon export (see section 4 below).

**NOTE**

When an image is corrected with **PRIME**, a blue band with the letter **P** is displayed in the upper left of the corresponding thumbnail.

The **Luminance** slider attenuates the grain present in the image, notably the high-frequency noise that can interfere with the finest details.

**Advanced settings**

Clicking on the + in the lower right corner of the **Noise Reduction** palette also gives you access to the following advanced sliders:

- **Chrominance**: Reduces colored noise (speckles of unwanted color, such as yellow on flesh tones, or blue on grey tones) to which the eye is particularly sensitive.
- **Low freq.** (RAW only): Corrects coarse (“low frequency”) noise, such as pixel clusters that can affect skin rendering.
- **Dead pixels** (RAW only): Reduces or eliminates “dead” pixels — camera sensor elements that for whatever reason fail to record the incident light correctly and show up as bright spots in the image. This happens mostly at high ISO settings, in dark images, and in long-exposure shots.

**NOTE**

DxO Optics Pro 9 lets you preview DxO **High Quality** noise reduction at all zoom levels. To improve your computer’s performance, you can change this behavior in the **Preferences**.
Horizon / Perspective

The Horizon / Perspective palette (Microsoft Windows and OS X)

About the horizon and about perspective
Two kinds of distortion can affect vertical or horizontal lines; one is simple, the other complex. The simple distortion is a tilted image: the horizon line is tilted up or down by a few degrees because the photographer tilted the camera by a few degrees when shooting. Such tilting can likewise result in a prominent vertical slant for a tree, a pole, a column. The solution to this problem is as simple as the cause: rotating the image in the opposite direction by as many degrees as it has been tilted.

Perspective distortions are much more complex. They occur whenever you shoot a camera and you are not square or face-on to the subject. The most well-known occurrence is when taking pictures of a building. If the building is tall, and/or you stand close when shooting, you will have to tilt the camera up to frame the entire building facade. In this case, all the parallel lines on the facade will become converging lines, and the building ends up looking like it’s falling over backwards.

A similar phenomenon occurs with horizontal lines if the camera is rotated around the vertical axis. The effects of both distortions combine if the camera is tilted in both directions at once. In such cases, the corrections are even more complex, requiring reconstruction of missing pixels and the modification of the image’s rectangular shape.

Reconstructing pixels means losing some detail, and modifying the rectangular shape of the image means losing some picture content. When appropriately applied, perspective corrections can significantly enhance your photos — not only for architectural images (which obviously will benefit from them the most), but even for portraits or landscapes.

NOTE
Straightening the horizon
This simple tool allows you to straighten the horizon automatically, without time-wasting trials (the tool is also available in the toolbar):

1. Click on the Horizon button.
2. Draw a reference line on the tilted horizon.
3. The image will automatically straighten itself as soon as you release your mouse or trackpad button.

Use the Ctrl/Cmd Z keyboard shortcut to undo. You can also rotate the image (from −180° to +180°) by using the Horizon slider, or by entering the degree of rotation desired in the rotation field.

Be aware that correcting perspective problems can result in losing a significant part of the image through cropping, so be sure to take this reality into account while shooting and to frame your photos accordingly.
Correcting perspective

**Force Parallel**
Clicking on the first tool, *Force Parallel* (⌘ or ⌘), will display two images of your photo side-by-side. The corrections will be performed in the left image, and the result displayed in real-time on the right. To apply the correction, draw two lines on image elements that you know are parallel (e.g., two columns, two sides of a door or portal, two angles of a facade).

**Force Rectangle**
Clicking on the second tool, *Force Rectangle* (⌥ or ⌥), will likewise display two images of your photo. Clicking anywhere in the left-hand image causes a rectangle to appear. Drag the corners onto an object that you want to become a perfect rectangle — a window, for example. This tool has a drastic effect, since not only will the two verticals become parallel, but the two horizontals as well, thus strongly modifying your image perspective. You should use *Rectangle* for small degrees of correction, when the camera is only slightly tilted out of its optimal position.

Fine-tuning the parallels and the rectangle corrections

A group of four sliders in the *Advanced settings* part of the palette allows you to fine-tune the parallel and rectangle corrections:

- **Up/Down and Left/Right**: These sliders give you additional control for adjusting perspective, with both sliders having a range of −125 to +125. They act as if the shooting plane (or more simply, the camera) was tilted forward or backwards around the horizontal axis (the Up/Down slider), and as if the shooting plane were angled to the left / right around the vertical axis (Right/Left slider).

- **Scale**: This slider lets you resize the image (from 50% to 200%) while maintaining its proportions. You can use it to bring back into the frame the picture elements eliminated by corrections.

- **Horizontal / Vertical ratio**: This slider lets you stretch or squeeze the height of your image while keeping the width unchanged. The scale runs from −100 (50% of the original height) to +100 (200% of original height). This tool is very useful if the picture seems excessively elongated in one dimension.

**NOTE**
You can reset or close the tool anytime by clicking on the *Reset* button on the right side of the *Viewer* command bar underneath the image.
Converging vertical lines have been made parallel again using the Force Parallel tool.

**Crop**

**Automatic cropping**
An image whose perspective has been corrected by the Horizon/Perspective tools generally loses some information at the edges – a great deal more if the correction is significant. This is why, by default, the Crop palette is set to Auto based on Perspective / Horizon by default, and the aspect ratio is set to Preserve aspect ratio, meaning that cropping is performed automatically on the corrected image, retaining as much information as possible.

- Selecting Preserve aspect ratio in the Aspect Ratio drop-down menu instead of Unconstrained will resize your image while maintaining its proportions (i.e. the relationship between its longer and shorter sides: for example 3:2 or 4:3).
- It is also possible to choose a different ratio in the Aspect ratio drop-down menu, such as 1:1 (a square format), 5:4 (replicating the traditional 5×4 or 10×8 format), or any other in the list. You can also type a ratio (2 figures separated by a colon) directly in the menu bar.

**Manual cropping**
- If you click on the Crop tool button, a dotted-line crop box will display on the image. You can move or extend this box by dragging its corners. If you have chosen a specific aspect ratio, the box will display the proportions of this aspect ratio, and you will be allowed to change only one of its dimensions, the other tracking automatically. If you have chosen an unconstrained aspect ratio, you will be able to freely change both dimensions of the box.
- To adjust a crop, you can also click on the Crop tool button. Once Crop has been enabled, select a point in the image, hold down the left mouse button and drag to create a crop box: it will appear as a black rectangular frame within the image.
- Clicking on and dragging the corners of the box adjusts its size. Clicking inside the box lets you move it around.
- Clicking outside the box removes the box and lets you create a new box from scratch.

When the crop tool is active, a command bar is displayed below the Viewer pane. From there, you can select a predefined aspect ratio, type in your own values, show or hide the grid overlay, reset and close the tool.
3.5.5. Light and Color – Advanced

The Light and Color – Advanced palette groups together the following expert-level tools for correcting color and tone: Color rendering, Style – Toning, Tone Curve, and HSL (Hue, Saturation, Lightness).

**Color rendering (DxO FilmPack not activated)**

Every camera, every processing software, and for traditional photography, every film, has a particular color rendering (and some renderings have contributed positively to their manufacturers’ reputations). The purpose of the Color rendering palette is to simulate the rendering of a camera X or a film Y. Beside aesthetic considerations, another use of the correction is linked to practical needs: many photographers who work with two or three different cameras want all of their image renderings to match. And professionals might also want also to deliver to their customers a neutral set of images that bears no noticeable signature of any particular camera.

![The Color rendering palette (Microsoft Windows)](image)

**TIFF or JPEG images**

As with several other corrections, Color rendering is inherently limited when applied to TIFF or JPEG images: the images have already been processed to some degree, and thus there is no access to the original file data. So for these formats, only certain film emulations are available.

You can access film options by combining certain choices found in the two drop-down menus, Category and Rendering [see below]. The Intensity slider allows progressive changing of the original image into the selected emulation. The default setting is 100, with 0 for the original image, and all values above 100 “hyper-correcting” the image.

**RAW images**

Because RAW images still contain all the luminance information and have never been converted into any color space, they are particularly suitable for the Color rendering correction. This means that many creative opportunities are open to you, as you can see from the contents of the two drop-down menus Category and Rendering.

**Generic renderings**

**Camera Body** is the camera default rendering: if you select a JPEG file, the rendering will match the manufacturer’s. In the second dropdown menu, you have the choice between four “neutral color” settings, which differ slightly only in the shape of their tone curves (i.e., contrast levels). Of these, the Neutral color, neutral tonality setting is our baseline for switching from any color rendering to another.

**NOTE**

DxO Optics Pro does not take into account the photo styles provided by some camera makers. However, it will try to match the standard original rendering as closely as possible.

Furthermore, the drop-down menus give you access to the following settings:

**Camera body**

When selected, this option reveals (in the second drop-down menu) a long list of cameras of different makes and models which DxO Labs has tested and measured, and whose color renderings you can use.
Color Positive Films

Without the DxO FilmPack plugin, DxO Optics Pro offers by default one single choice, **Color-positive films**, a selection of generic positive films.

**NOTE**

If DxO FilmPack is not installed and activated on your computer, the available analog film simulations will be limited to a very small list of well-known positive color films (Kodachrome, Fuji Velvia, etc.). However, if DxO FilmPack is activated, you can take advantage of more than 60 different film types [for more information, see the DxO FilmPack user guide, available in the DxO Academy at http://www.dxo.com/intl/photography/tutorials].

**ICC Profile**

Choosing **ICC Profile** opens a dialog box for browsing your file system to find color profiles that you might want to use. Remember that an ICC profile is a set of data that characterizes any visual device such as a camera, a screen, a scanner, etc. As with JPEG or TIFF images, an **Intensity** slider allows a progressive change of the image’s original color space into another. At 0, only the original image appears; 100 is the default setting; and above 100, the image is “hyper-corrected.”

**Protect saturated colors**

The **Protect saturated colors** correction prevents some specific saturated colors from being clipped, which may lead to unnatural colors and loss of texture when a particular color channel is close to the minimum or to the maximum luminance intensity (0 or 255). This process is performed automatically; you can fine-tune or modify the result with the Intensity slider. Clicking on the magic wand restores the image to the original automatic setting.

Note that the slider has an effect only when you are applying a particular color rendering:

- On RAW images, it always has an effect since a color rendering is applied (by default, this is the color rendering of your camera body).
- On JPEG images, the camera body has already applied the color rendering, so DxO Optics Pro does not apply any particular color rendering unless you explicitly ask for it.

**Style – Toning (DxO FilmPack not activated)**

The Style – Toning palette contains four presets which influence the overall contrast and saturation of the selected photos by reproducing four classic styles:

- **B&W**: Black and white conversion of a color image, based on its contents.
- **Landscape**: Greens are enhanced.
- **Portrait** puts the emphasis on skin tones.
- **Sepia**.

You can adjust the effects with the **Intensity** slider. The default value is 100, and 0 corresponds to the original image.

**NOTE**

The contents of the **Style – Toning** palette depends on whether or not DxO FilmPack has been activated. For more information, see section 3.5.6 on DxO FilmPack below.
**Tone Curve**

The tone curve can be adjusted either channel by channel or globally [Microsoft Windows]

**About the Tone Curve**

The **Tone Curve** is a powerful but complex tool. We recommend practicing a bit before attempting to correct real photos. Note that many results obtained with the Tone Curve can also be obtained by using the HSL palette or DxO Smart Lighting and Selective tone in the Essential Tools palette.

The **Tone Curve** translates input tonal values (light received) to output tonal values (light seen in the image). The simplest case is one in which the tone curve is a straight line ascending at 45° from the origin, as in the illustration above. Such a tone curve is neutral: every input value of light, whether in dark, medium, or light tones, is translated exactly into the same output value. Input values (from 0, the darkest, to 255, the lightest) are on the x-axis, output values (similarly running from 0 to 255) are on the y-axis.

You can subtly change and redraw tone curves region by region, and even color by color, to suit a particular photo. Quite often this takes the form of an “S-shaped curve” that compresses the dark shadows and the highlights, but expands the mid-tones. This can often result in a more contrasty, “punchy” — and ultimately more pleasing — image. But once again, playing with the tone curve is not a matter of set recipes; it is a complex matter that takes practice and experience.

**Modifying the Tone Curve**

You can set the slope of only the central part of the curve (the “gamma”) by adjusting the slope value in the middle of the x-axis with the Gamma slider, set to 1 by default. Values can range from 0.05 to 6.00:

- Values above 1 increase the contrast and bring out details in shadow.
- Values below 1 reduce the contrast and bring out details in highlights.

Redraw the curve by defining and then moving points on the neutral curve (most often one point in the light shadows and one point in the first highlights, but more points are possible). Define points by clicking on the curve. (Active points are filled; inactive points are shown as white squares.) You can drag an active point toward the top or the bottom to modify the curve.

**NOTE**

An active point can be deleted by right-clicking or by pressing Delete.

You can modify the black and white points on the x-axis and on the y-axis either by dragging them along their axis, or by entering the desired value in the adjacent boxes.

The drop-down menu at the top of the **Tone Curve** palette lets you apply the tone curve either to all three color channels (RGB) simultaneously, or channel by channel. Two reset buttons to the right let you revert to the default neutral curve (straight line at 45°) either channel by channel, or for all three channels at once.
HSL (Hue, Saturation, Lightness) system

Among the multiple systems used to describe the colored spaces, the HSL system is well-known for its effectiveness and simplicity. Each color has three parameters: its hue [H], its saturation [S], and its lightness [L]. This correction is available for each of the six color channels in an image:

- The additive colors (RGB: Red, Green, and Blue).
- The subtractive colors (CYM: Cyan, Yellow, and Magenta).

Hue

The Hue slider modifies the tint of the selected channel. As an example, if you select the yellow channel, moving the slider to the left will progressively change all the yellows in the image to magenta, and if you move the slider to the right, the yellow will change into green. The slider has a range of values from $-180^\circ$ to $+180^\circ$ because hue is classically illustrated as a circle on which all colors are located.

Saturation

The Saturation slider determines how strong a color or a tint is. If we carry on with the yellow channel as an example, moving the slider to the left progressively removes the color until the yellows in the picture turn gray. On the other hand, moving the slider to the right reinforces the yellows, turning them into orange near the end of the range. The slider can be adjusted from $-100$ to $+100$.

Lightness

The action of the Lightness slider is easy to understand if you look at its effect on the Histogram. Moving the slider to the right shifts the black point to the right, compressing the tonal range into the upper half of the scale. Conversely, moving the slider to the left brings the white level down towards the black tones, compressing the tonal range into the lower half of the scale. In short, still using our example, moving to the left will make yellows darker and deeper; moving to the right will make them brighter and lighter.

Reset

The Reset button cancels all HSL corrections and resets all the sliders to their default value of 0.

NOTE

If you want to correct several colors, we suggest you make note of the correction values you use for each color layer, so that you can fine-tune a particular correction without having to start over again: moving a color just a few points can have a significant effect!

Multi-Point Color Balance (OS X only)

The usual rule in photography post-processing is that when you change one color, even slightly, all the other colors are affected. The multi-point color balance tool makes it possible to get round this.

To transform a color, click on the Multi-point Color Balance tool:

- The photo will display in two copies, one original, on the left, on which you will use the tool, and one for the corrected image on the right.
- The mouse pointer turns into a cross (+) when in the left image. Use this “modified cursor” to select the zone with the color that you want to change.
- Clicking on the + cursor transforms it into a wheel (you can create up to four targets in the same image) with two controls:
  - A rotating radius controls the color to which the selected color will be changed.
  - A small circle lying on the above-mentioned radius, which can slide from the center to the circumference of the circle, controls the degree of saturation: from 0 (at the center) to 100% (at the circumference of the circle).

This control can be applied to up to four colors in the image, but if even you only want to change one color, it can be effective to click on adjacent colors to protect them from being affected.

It can be helpful to enlarge your image when using this tool and to use the Hand tool (by holding down the Space bar) to move around within the image, so you can more easily distinguish the area whose color you want to modify. To get the most benefit out of this tool, we recommend that you practice using it on, for example, areas in the sky.
Controls and commands
Several commands let you adapt the multi-point color balance tool to suit your needs:

- The **Intensity** slider lets you regulate the change made on the image: when the slider is set to 0, all of the original image is kept, and no correction is applied; when set to 100%, nothing remains of the original image, and the correction is fully applied.
- Checking the **Preserve White Balance** box moderates the effect of the correction by keeping the grey tones from being altered by the color changes.
- The **Radius** slider under the image to the left changes the size of the zone used to pick up the source color.

3.5.6. Detail and Geometry – Advanced
About the Detail and Geometry – Advanced palette
The **Detail and Geometry – Advanced** palette lets you perform the following additional corrections:

- **Unsharp Mask** increases the apparent sharpness of the image.
- **Moiré** reduces or removes colored artifacts in the image.
- **Dust** helps to erase dust spots in your photos.
- **Volume deformation**: corrects the distortion of spherical and cylindrical objects photographed with a wide-angle lens.

Unsharp Mask
About Unsharp Mask
The purpose of the **Unsharp Mask** tool is to sharpen an image. The tool makes a blurred copy of the original picture, then subtracts the original from the blurred copy, leaving the finest details, which can then be enhanced.

![Unsharp Mask palette](image)

The **Unsharp Mask** palette includes the following four sliders:

- **Intensity** sets the amount of sharpening to be applied to the whole image.
- **Radius** sets the thickness of the edges to be sharpened.
- **Threshold** sets the level above which details will be sharpened, and below which they will be left as they are, making it possible to avoid sharpening the smallest details that look just like noise.
- **Edge offset** lets you homogenize the sharpness between the center and the edges of an image.

**NOTE**
75% zoom is the minimum level for working with the **Unsharp Mask** palette corrections; however, we recommend that you always choose to work at at least 100% zoom to ensure accuracy and efficiency.
Using the Unsharp Mask

The **Unsharp Mask** correction is disabled by default. It is unnecessary for JPEG files, as in-camera processing has already sharpened them, and it is usually unnecessary for RAW images for which a DxO Module is available. This means its use is really confined to unsharpened JPEG files and RAW files without a DxO Optics Module. (In the latter instance, we advise fine-tuning the **Unsharp Mask** settings, and then creating a preset.)

We recommend that you try fine-tuning the three sliders using these starting values: Intensity = 100, Radius = 0.5, and Threshold = 4. For most images, Threshold should stay within a range from 4 to 10. Radius determines how subtle the correction is: excessive values will result in haloes. Finally, you can set the Intensity slider up to 200.

**NOTE**

The negative values in the Intensity slider (from $-100$ to $0$) can be used to soften instead of sharpen an image (which can be useful for portraits).

![Manual sharpening (displayed at 100%) for an older lens for which no DxO Optics Module is available](image)

**Moiré**

Moiré appears as colored artifacts or patterns when fine, high-frequency details interfere with the camera sensor. This is particularly true for cameras with weak or no low-pass filters. The photos they produce are sharper than those taken with traditional digital cameras (which use strong bypass filters), but the risk of introducing moiré will be much higher. Moiré is especially apparent in image details such as tile roofs, wire fences, mesh, feathers, fur, hair, and fabrics.

The **Moiré** Intensity slider helps to reduce or recover these artifacts. Its range goes from 0 to 100, with 100 as the default value. After any adjustments, you can reset to the default value by clicking on the magic wand.

**TIP**

The effect of this tool can only be previewed if your image is displayed at 75% zoom or higher.

**Dust**

The anti-dust tool allows you to “paint” a line (whose thickness can be adjusted) or to position a dot (whose diameter can be changed) over a dust spot or other unwanted detail you would like to erase.

Clicking on Tool in the **Dust** palette displays a dual image: original on the left, corrected on the right. Zoom in on the original image and use the slider at the bottom of the Viewer pane to set the width of your tool. Then click on a spot or draw a line while holding down the cursor button at the desired place. The active correction will show as cyan, the inactive (unselected) corrections are magenta.

To remove an unwanted correction, use the tool to click on it again and then press the Delete key on your keyboard. To remove all corrections made on the image, click on the **Reset** button below the left-hand image.
Each blue dot corresponds to a dust speck in the original image that will be corrected in the processed image (at right)

Volume deformation

The Volume deformation palette (Microsoft Windows)

About volume deformation

Representing the three-dimensional world in a two-dimensional image raises a fundamental difficulty. The laws of optics cannot be overturned: when converted into a flat image, the shapes of certain 3D objects appear distorted and no longer match what our eyes and brain expect to see. This phenomenon is referred to as “volume anamorphosis” (called “volume deformation” in DxO Optics Pro for clarity). It is most noticeable when using a wide-angle lens and/or when shooting objects in the foreground, close to the camera, and/or near the edges of the image.

The main difficulty when correcting this distortion is that it is entirely photo content-dependent. DxO Optics Pro algorithms are powerful enough to make intelligent automatic corrections, but in some cases you might want to do manual corrections based on your own experience and taste.

Choosing between spherical or cylindrical corrections

The first step in the correction process is to identify the kind of deformation. There are two main types: cylindrical and spherical.

Basically, cylindrical objects (for example, columns or a human body) need correction along one axis (usually the vertical axis) more than another. To put it another way, a standing human body can be represented by a cylinder. On the other hand, spherical objects (such as a human head) need correction on both axes simultaneously.

The Volume deformation palette has a drop-down menu from which you can choose between cylindrical or spherical corrections. Usually the spherical correction is the most useful, but we recommend that you try both to find the best result, especially if you are not sure.
If you click on **Advanced settings**, you can fine-tune the corrections with the following sliders:

- **Radial intensity** for recovering spheres (default value: 150).
- **Horizontal intensity** and **Vertical intensity** for recovering cylinders (default values, respectively, are 100 and 0).

The sliders have a range of 0 up to 200%.

The photo at right shows the effect of the volume deformatino correction on human bodies and faces, compared to the strong deformations in the original image at left.

### NOTE

Using the grid overlay on the image [Ctrl+G or G] will help you better visualize the deformations and their corrections.

#### 3.5.7. Optical corrections

**Main tools**

The **Optical Corrections** palette contains the following correction palettes:

- **Distortion** corrects the pincushion and/or barrel distortion that affects most lenses.
- **Vignetting** corrects the darkening of the image corners and edges that can occur especially when using wide-open aperture values.
- **Chromatic aberrations** removes the color fringes seen along high-contrast edges, particularly in the image corners and along edges.
- **Lens softness** compensates for the differences in sharpness between the center of the image, which is always better, and the edges, where it is softer.

You can use all these tools automatically if a relevant DxO Optics Module is available, or manually if that is not the case.

**Secondary tools**

If the focal length or focusing distance is inaccurate or is not properly recorded in the EXIF metadata, the **Optical Corrections** palette will automatically display the appropriate sliders to allow you to manually input the data.
Optical corrections – Principal tools

About distortion correction

The two principal types of distortion: pincushion (left) and barrel (right)

About distortion correction

The geometric distortion introduced by a lens may be in pincushion or barrel form – or sometimes even a mixture of the two. In each case, DxO Labs’ analytical measurements make it possible to correct the distortion such that straight lines in the original scene are correctly reproduced as straight lines in the photo.

The Distortion correction has just one slider, Intensity, that controls the degree of the correction, with a range from 0 to 100%. The default setting is 100%, and you should only depart from this either to avoid the cropping of important details near edges, or for creative reasons.

The Correction drop down menu allows you to select either automatic correction based on a DxO Optics Module, or manual correction. (Only the manual option will be active if a DxO Optics Module is not available.)

Automatic distortion correction

Provided the appropriate DxO Optics Module is loaded on your computer for the image you are working on, DxO Optics Pro will automatically correct any distortions.

Manual distortion correction

Select Manual in the drop-down menu if the relevant DxO Optics Module for your camera/lens combination is not available, or not loaded on your computer, or for creative reasons. In any case, first select the type of distortion you want to correct: Barrel, Pincushion, or Fisheye (for fisheye lenses).

TIP

If you are correcting an image manually, it can be helpful to display a grid over it by selecting Show Grid overlay in the View menu or by using the shortcut keys Ctrl + G (Microsoft Windows) or simply G (OS X).

Changing a fisheye lens into a super-wide-angle lens

You can automatically turn your fisheye shots into ultra-wide-angle-style photos without circular distortion if the camera/fisheye lens combination is supported by a DxO Optics Module. You can also manually correct this distortion by using the Intensity slider after choosing the Fisheye option in the Distortion type drop-down menu.

TIP

If you use the Fisheye correction tool, try deselecting Keep aspect ratio to recover a larger field of view in your picture.
Maintaining the aspect ratio
Most of the time the distortion correction changes the aspect ratio (i.e., the ratio between width and height) of the image. Since the aspect ratio is of great importance, especially if the photo is to be published, it is maintained by default, resulting in some cut-off (cropped) parts along the image edges. If you want to make sure that the entire usable part of the image stays visible, uncheck the Keep aspect ratio box at the bottom of the palette.

Vignetting
Vignetting is an optical aberration that results in corners and edges that are darker than the center of an image. The vignetting correction works differently and uses different commands depending on whether or not the relevant DxO Optics Module is available.

DxO Optics Module available
When a DxO Optics Module is available, the Correction drop-down menu will display Auto with DxO Optics Module, and the correction will be automatic. From there, if you want, you can either fine-tune the automatic correction, or use the Correction drop-down to switch to Manual mode.

The vignetting correction actually takes place in two steps, both of which can be fine-tuned:

1. First, from the lens data, focal length, and aperture setting, the DxO Optics Module calculates the necessary correction for every pixel in the image. The Intensity slider allows you to decide how much vignetting should be removed (within a range 0 to 100%).

2. Second, a filter is applied to avoid clipping in bright areas and increased noise in dark areas. You can use the Middle slider to set the intensity of this filter, from 0 to 100%, as follows:
   - If set to 0%, the vignetting correction will be applied without any restrictions.
   - If set to 80%, for example, the largest highlights and shadows will remain uncorrected.

When adjusting these two combined settings, we suggest sticking to the default 100% for the first Intensity slider, since the Middle slider is usually more effective in preventing undesirable vignetting correction side effects. Only vignetting due to the lens or sensor is corrected. Mechanical vignetting caused by a lens shade, for example, cannot be corrected. In the case of mechanical vignetting, you may want to use the Crop tool to remove the unwanted parts of your picture.

As with many other DxO Optics Pro corrections, the magic wand allows you to revert to the default settings.

No DxO Optics Module available
If there is no DxO Optics Modules available, the manual correction mode will allow you to adjust the degree to which the corners of the image need to be lighter. You can use the Middle slider to adjust how far towards the center of the image the correction will be applied.

Be careful not to apply a too-strong correction: the corners of the image should not be lighter than the center!
**Chromatic aberrations**

*About chromatic aberrations*

Chromatic aberration results from different colors focusing at slightly different places, and leads to defects which can be easily seen at the edge between two contrasting areas: green and red halos (so-called lateral AC), and/or purple-only or green-only halos (longitudinal AC). A particular phenomenon that is also mostly due to chromatic aberration, “purple fringing” is when a ghost-like purple image appears along highly-contrasted edges.

*Correcting chromatic aberrations*

Lateral chromatic aberration (e.g., magenta or green fringes along edges) is automatically corrected only if the appropriate DxO Optics Module is available. In this case, no further manual action is necessary. You can correct the other types of chromatic aberrations (longitudinal or other) using the two sliders in their respective sections of the palette:

- **Intensity** sets the strength of the correction, within a range of 0 to 200.
- **Size** adjusts the width of the colored fringe to be suppressed, within a range from 0 to 12 in arbitrary units. This setting affects how DxO Optics Pro determines the chromatic aberration to be corrected, and what is real image content.

You should check the **Purple fringing** correction box for all backlit scenes, or when shooting with a lens prone to this optical defect.

![For most images, the need to correct chromatic aberrations and purple fringing is unavoidable](image)

**DxO Lens Softness**

*About lens softness*

DxO Optics Pro’s exclusive **DxO Lens Softness** tool is one of its major strengths. Lens softness is an optical aberration which results in a point being transformed by the lens into a small blurred circle. (This should not be confused with out-of-focus or motion blur, which DxO Optics Pro does not correct.) DxO Optics Modules have been created by measuring the amount of blur for every point in the image area for each supported camera body and lens combination.

By matching the shooting parameters contained in the EXIF data (aperture, focal length, etc.) with the map provided by the DxO Optics Module, DxO Optics Pro can apply precisely-tailored corrections to each pixel in the image field. This correction is not the same over the whole image, since lenses are sharper in the center; therefore central pixels need less correction than those at the edges.

**NOTE**

The **Lens Softness** palette is visible only for images for which the appropriate DxO Optics Module is loaded. If no module is available, you should use the **Edge offset** slider in the **Unsharp Mask** palette (in the **Detail and Geometry – Advanced** palette) to manually adjust the sharpness in image corners.
The Global slider

DxO Labs has defined an average setting for the Global slider, which is set at −0.50. Negative settings from −2 to 0 do not soften or reduce image sharpness: they are simply a lower level of correction (the corrected image will always be at least as sharp as the original image). Even the 0 level has some degree of sharpening compared to the original photo. To reduce overall sharpness correction (for a portrait, for example), move the Global slider to the left; to increase it, move the slider to the right. DxO Lens Softness is a “smart” correction, which limits its effects in noisy areas of the image, or when the ISO setting is high.

**NOTE**

It is important not to increase the sharpness of a shot that has already been sharpened by the camera, as is the case for JPEG images. So if you intend to post-process your images, you should shoot without any in-camera sharpening.

The Details slider

The Details slider is set at 50 by default and is used to enhance the micro-contrast of fine details in the image. This subtle correction can be very worthwhile for use in landscapes, but should be reduced to a minimum for portraits, where a certain degree of softness is needed to hide (for example) skin blemishes.

**NOTE**

Unlike the Unsharp Mask tool, enhancing details with the DxO Lens Softness tool does not create white edges or halos around the sharpened areas.

The Bokeh slider

The Bokeh slider reduces artifacts in the bokeh (i.e., the out-of-focus area in your photos, mostly in the background) that can appear when using the sharpening tools. However, reducing those artifacts will slightly reduce the sharpness of the in-focus areas of your image.

DxO Lens Softness and Unsharp Mask

We recommend that you perform as much of your sharpening as possible using the DxO Lens Softness correction tool before using the Unsharp Mask. Of course, for images where the appropriate DxO Optics Module is not installed, you will have to use the Unsharp Mask for all manual sharpening tasks.

**Optical Corrections – secondary tools (OS X)**

Focal length and focusing distance

The lens focal length and focusing distance of a photo are recorded in the EXIF data of your images. However, this information is not always accurate. For example, different but close positions of the focal length ring (say, 17 and 18 mm) could result in the same value (say 18 mm) being recorded in the EXIF data. In this case, the distortion correction may be less than optimal. In the same manner, the focusing distance might be recorded in the EXIF data with insufficient precision, and similarly lead to an imprecise correction. In both cases, to improve the effectiveness of the optical corrections, you can provide more accurate values in one (or both) of the rollups that appear in the Geometry palette:

- **Focal length**: Use the slider to specify the lens focal length.
- **Focusing distance**: Select a range for the focusing distance in the drop-down menu, then fine-tune with the slider.

3.5.8. DxO FilmPack

**About the DxO FilmPack palette**

This palette appears if the DxO FilmPack plugin has been activated. It integrates the film emulations and editing tools specific to DxO FilmPack with your usual workflow in DxO Optics Pro. Several palettes are at your disposal:

- **Color rendering**: This palette is a duplicate of the Color rendering palette found in the Light and Color – Advanced palette. It lets you simulate the color rendering of a given camera, an ICC profile, or any of a vast choice of analog films (black & white, color negative, etc.).
- **Style – Toning**: Duplicates the Style – Toning palette in the Light and Color – Advanced palette. It allows you to apply a number of tonings as well as specific color profiles (e.g., landscape, etc.).
• **Filter**: Simulates lens filters.

• **Grain**: Lets you apply a specific grain type from more than sixty films, color as well as B&W, and to set the size of the grain.

• **Channel mixer**: Allows you to manually adjust the balance among the six main color channels (additive colors RGB, and subtractive colors CYM) to obtain a superior black-and-white conversion from a color file.

• **Creative vignetting** (available only in the Expert edition of DxO FilmPack): Increases or decreases the amount of light shown on the periphery of the image. In particular, it allows you to frame and enhance the image center.

• **Creative blur vignetting**: Like Creative vignetting, this tool lets you apply an effect to the periphery of your image, but this time the effect is blurred so as to draw greater attention to the main subject.

• **Frame**: Lets you place a frame around your image; different styles are available.

• **Texture**: Allows you to simulate scratches or tearing on analog film negatives.

• **Light leak**: Lets you reproduce the effects of aging analog film negatives or problems related to accidental exposure of analog film to light.

---

**NOTE**

For more information about the different presets available in the palettes mentioned above, consult the DxO FilmPack 4 User Guide.

### 3.6. Presets

#### 3.6.1. About DxO Optics Pro presets

The visual presets window

A preset is a set of corrections that you can apply in one go to any pictures in DxO Optics Pro. The goal of the presets is to help you to record and keep track of your favorite corrections, and to ease and accelerate your workflow within the application.

Two kind of presets exist in DxO Optics Pro:

• **Full presets** cover all the existing corrections available in the Customize tab, meaning that each correction has a status of either activated [with defined setting parameters] or deactivated.

• **Partial presets**, on the other hand, cover only a limited number of corrections among all existing corrections, with the status of some corrections remaining undefined.
As soon as you open an image in DxO Optics Pro, the default full preset **DxO Standard** is automatically applied. You can choose a different preset as the default if desired.

### 3.6.2 The different categories of available presets

DxO Optics Pro offers a set of 30 full presets divided into five categories: **General use**, **Portrait & Landscape**, **Black & White**, **Atmospheres**, and **High Dynamic Range (single-shot HDR)**.

#### General use

The General use category comprises four presets:

- **DxO Standard**, which is systematically applied to your images while you are going through the image files in the Source Browser. This full preset is composed of the following activated corrections (all other corrections have been deactivated by design and so are not included below):
  - Exposure on Auto.
  - DxO Smart Lighting on Slight.
  - Color rendering unchanged for JPEG images, and set to the camera body default rendering for RAW files.
  - Protect saturated colors on Auto.
  - Noise Reduction on Auto.
  - Distortion on Auto.
  - Vignetting on Auto.
  - Chromatic aberration on Auto (with correction of lateral chromatic aberration activated).
  - DxO Lens Softness activated and the Global slider set to – 0.50 [or the default settings for Unsharp Mask, activated if a DxO Optics Module is not available].

- **Neutral colors** is identical to DxO Standard, except that the colors are less saturated and the contrast is less pronounced.

- **Black and white** automatically converts an image based on its content.

- **No correction** deactivates all of the corrections in DxO Optics Pro, so images are displayed “as shot.” In the case of RAW files, DxO Optics Pro still performs demosaicing using all of the basic settings that are optimal for your camera.

#### Portrait and Landscape

The **Portrait and Landscape** category is composed of two groups of presets that have been designed for these two use cases. For portraits, for example, the contrast is softer and the skin tones have been optimized, whereas for landscapes, the contrast and the colors have greater emphasis. The following eight presets are available in this category:

- **Portrait - Standard**
- **Portrait – Bright**
- **Portrait – Candy colors**
- **Portrait – High key**
- **Landscape – Standard**
- **Landscape – Polarized postcard**
- **Landscape – Contrasty**
- **Landscape – Washed out**
Black & white
The Black & White category also provides eight presets that let you modify your images by playing with the contrast. You will find here presets that are adapted for “masculine” and “feminine” portraiture and for landscapes; presets that produce highly-detailed images, and others which are shrouded to give a dream-like effect. Of course, all of these presets can be applied to any subject:

- B&W – Dense
- B&W – Structured
- B&W – Dramatic skies
- B&W – Low key
- B&W – For her
- B&W – For him
- B&W – Subdued
- B&W – Veiled

Atmospheres
The Atmospheres category offers eight creative presets based on toning. They can be applied to both color and black & white images:

- Mist
- London night
- Blue hour
- Twilight
- Old film
- Polar
- Heather purple
- Old school

High Dynamic Range (single-shot HDR)
This category contains four presets that simulate HDR effects — that is, images with an extended dynamic range but with a tonal range that is redistributed to be used without having to use special software or 32-bit files. These single-shot image presets do not require combining multiple images shot at different exposures, and can be used on both RAW and JPEG files:

- HDR – Slight: Provides a moderate HDR effect based solely on the DxO Smart Lighting correction.
- HDR – Realistic: Provides a less-pronounced HDR effect than the preset immediately preceding. Restores highlights, lightens shadows, and has a reasonable effect on the tone curve and vibrancy.
- HDR – Artistic: Provides a marked HDR effect. Restores highlights, strongly brightens shadows, and emphasizes the tone curve and vibrancy.
- HDR – Black & White: Optimized for monochrome images, this effect strongly accentuates contrast.
3.6.3. Applying a preset

**Applying a predefined preset**

To apply a preset to your image, click on the Presets (Microsoft Windows) or the Apply preset (OS X) button in the command bar, which will then display the visual preset window showing how all the available presets will affect your image. Click on the preset you want to apply, which will close the visual preset window and immediately apply the selected preset to the image in the Viewer.

**TIP**

You can also right-click on a thumbnail in the Image Browser and select Apply Preset in the context menu, or click on the preset of your choice in the list in the Preset Editor.

**Combining presets**

You can use more than one preset on an image. If each preset has a different value for the same correction, the rule is simple: The values of the last applied preset take precedence; for example:

- If the first-applied preset gives a value of Disabled for a correction, and the second preset gives the value of Enabled to the same correction, the correction will be Enabled (that is, active).
- If both corrections are set to Enabled, with the first preset supplying a value of, say, “−2,” and the second preset supplying a value of “+1,” then the correction value will be “+1.”

This rule in particular makes it possible to create partial presets that are based on a limited range of corrections to be applied on top of “global” (or full) presets. When a correction is assigned a value by the partial preset, it will be governed by it. When there is no value assigned to a correction by the partial preset, the correction will be governed by the underlying full preset.

3.6.4. Creating a full preset from current settings

To create a preset from current settings:

1. Correct your image.
2. When you are satisfied with the results, right-click on the image thumbnail in the Image Browser, and select Create preset from current settings in the context menu.
3. Enter a name for your preset in the dialogue box and click on Save.
4. The new preset will appear in the Visual Presets window and in the list in the Preset Editor.

**NOTE**

Any preset that you create in this manner will affect all setting values, as it is a full preset.

3.6.5. Managing presets with the Preset Editor

The Preset Editor lets you create a preset by defining each correction setting (Microsoft Windows and OS X).
The Preset Editor is a palette in the Customize tab that lets you create and manage your own custom presets, including those that you create "from scratch," and others that you can create by modifying existing presets.

**Preset Editor commands**

**Microsoft Windows**

The Preset Editor palette includes the following commands:

- **New preset group**: Creates a folder in which you can group similar presets: by type of camera used, speed rating, landscape rendering, portrait, etc. (Presets can be moved from one folder to another using drag-and-drop.)
- **New preset**: Creates a blank preset, without any settings selected. (If you have selected a folder before you create your preset, the preset will be created in that folder.)
- **Duplicate the selected preset**: Makes it easier to create a preset by using an existing preset (you will need to use this method if you want to create variants of a locked DxO preset).
- **Delete**: Deletes the selected preset or folder.
- **Import**: Lets you import presets that you created previously in other versions of the program, or that are available on another computer.
- **Export**: Makes it easy to export a preset to a folder that will be copied onto another computer or sent via email.
- **Create new preset from image**: Uses all the settings of the current image to create a new preset.
- **Edit**: Lets you change the setting parameters of an existing preset.
- **Save**: Saves the changes you make to a preset.
- **Apply**: Lets you apply a preset to a selected image.
- **Cancel**: Lets you cancel the changes made to a preset.

**NOTE**

A locked preset (marked with a padlock icon) is one that is provided by DxO Optics Pro, so you cannot modify or delete it.

You can create as many presets as you want and save them in custom folders, import them into other sessions or versions of DxO Optics Pro, and export them to share them with other users.

**NOTE**

To verify or to change a preset’s settings, select it in the Preset Editor and then click on Edit: the relevant palettes will then be displayed in edit mode.

**OS X**

The Preset Editor palette includes the following commands:

- **New preset**: creates a blank preset, without any settings.
- **New group**: creates a folder in which you can group similar presets.
- **Duplicate the selected preset**: creates a preset by using an existing preset.

A drop-down menu is also available in the top right corner of the palette, with the following commands: New Preset, New Group, Duplicate Preset, Rename, Remove, Apply Preset, Edit Preset, Save, Save as a copy, Discard changes, Import (it is possible to import several presets simultaneously), and Export.
Modifying a preset from an existing preset

Microsoft Windows and OS X

To create or to change a preset based on an existing preset:

1. Click on the preset that you want to change.
2. Click on the **Edit** button on the top left of the **Preset Editor** palette. The relevant correction palette tools will switch to editing mode (indicated by blue banding on the left edge of the palettes).
3. Uncheck the settings in the palettes that you want to deactivate, or modify the setting parameters as desired. You can expand the hidden palettes to activate, deactivate, or modify their settings.
4. When you are finished making all the changes to the settings, click on the **Save** button in the Preset Editor palette.
5. Click again on the **Edit** button to quit the create/edit preset mode.

**NOTE**

To create a variant of a locked DxO preset, click on the **Copy** button in the command bar of the **Preset Editor** and then rename the copy.

**NOTE**

In all cases, changes to preset parameters can be canceled either by selecting **Undo** in the **Edit** menu or by using the Ctrl/Cmd + Z keyboard shortcut.

**Preset folders**

You can open folders in the preset folder list by either double-clicking on them, or by a single click on the arrow on the top left. Clicking on the name of a folder lets you rename it, just like the way you rename a file. Preset folders are ordered alphanumerically. We recommend that you give your folders meaningful names so that you can easily group and find your presets.

3.7. **Virtual copies**

3.7.1. **About virtual copies**

A **Virtual copy** is a duplicate of a Source image on which you can try out various corrections. You can create and experiment with as many virtual copies as you wish to apply many different correction settings and compare them to one another.

3.7.2. **Creating or deleting virtual copies**

To create a virtual copy:

1. Choose the image you want to make a virtual copy of in the **Image Browser**.
2. Right-click on its thumbnail and select **Create a virtual copy** in the contextual menu. You can also choose the same command in the **Image menu**, or use the keyboard shortcut Ctrl + J (Microsoft Windows) or Cmd D (OS X).
3. A new thumbnail will appear in the **Image Browser** next to the image source (per default sort criterion “file name”; using different sort criteria can result in a different order).
4. The original will show the the sequence number 1 in the lower left corner of the thumbnail, and each virtual copy will be assigned a sequence number (2, 3, 4, and so on).

**NOTE**

Virtual copies behave exactly like an original image: you can organize them in projects (along with original files), apply any correction or preset, process them by exporting, and print them.
To delete a virtual copy:

1. **Right-click** on the copy thumbnail in the Image Browser.
2. Choose **Delete** in the context menu.

**NOTE**

You cannot delete a virtual copy while you are working in the project to which it belongs. You can remove it from the project, but it will still exist and be visible when you open the folder containing the original image.

### 3.7.3. Using a virtual copy as a reference image

The previous steps explained how to create (unlimited) virtual copies which you can compare, one at a time, to the source or original image. But you might want to go a step further and compare virtual copies among themselves without having to use the source image. To do so, follow these steps:

1. In the command bar in either the Organize or Customize tab, click on the small arrow located next to the **side-by-side** display button to access the **Select a comparison image** drop-down menu.
2. A list of all of the copies of the image in the Viewer will be listed in this menu. Some may be grayed out and marked as Needs to be processed; others may be active.
3. Choose one image from the active set. This image is now the reference image, and will appear on the left side of the comparison display. You can compare these virtual copies without having to go through the source image.
4.1. About the Export feature

DxO Optics Pro 9 features an export system that is fully integrated with the Organize and Customize tabs and that comprises four functions:

- **Export to disk**: Exports your images to a hard drive.
- **Export to application**: Lets you open image files (including RAW files) in external applications.
- **Export to Facebook**: Lets you transfer images to your Facebook page.
- **Export to Flickr**: Transfers your images to your online Flickr gallery.

Exporting is the last step in the DxO Optics Pro workflow — the moment when all of the corrections you’ve made will be applied to the images you export to share with or send to your clients, friends, and family.

4.2. Interface

The Image Browser command bar contains two buttons that are relevant to the Export function:

- **Export to disk**, to Application, Facebook, or to Flickr via a drop-down menu
- When you choose any of the three export options above, a progress button will display. Clicking on this button will open a floating palette that will display progress bars for all of the exports underway.

**TIP**

To cancel an export, click on the progress button and then in the floating progress panel, click on the X next to the progress bar of the export that you want to cancel.

The floating progress palette displays a record of all of the exports performed during a session. You can delete the list of completed exports by clicking on the Erase button in the lower left corner of the palette.

**NOTE**

There are two instances in which the export progress button is not visible: (1) after you launch DxO Optics Pro and thus have not yet exported anything, and (2) after you have erased the contents of the progress palette.

4.3. Export to Disk

4.3.1. About exporting to disk

Exporting images consists of creating image files to which are applied the corrections you made in the Customize tab (in other words, processing the images), and then by transferring the corrected images to the hard drive and the folder of your choice, or to an external application, or to a Flickr gallery. All export choices require you to choose an output option.
The Export to Disk – Options floating window (Microsoft Windows on the left, OS X on the right) that lets you define the output formats, destination folder, file name suffix, image size, and ICC profile.

The three respective output options windows offer you a number of settings that allow you to automatically export images in different formats and from different destinations. There is no limit to the number of output options that you can create, so long as you give them different names (e.g., JPEG HQ, poster print, JPEG medium, JPEG Web, TIFF archiving, and so on).

### 4.3.2. File formats and their constraints

Some image formats lose part of the file information to achieve a more compact size; these are referred to as lossy. Formats that keep all available information even while achieving a certain degree of compression are referred to as lossless.

JPEG is a lossy format, while TIFF and most RAW formats are considered lossless. DNG (Digital Negative, ©Adobe) is a very specific format designed by the Adobe software company to be a de facto standard for RAW files, which it has become to some extent.

The following table shows the possible relationships between input and output formats:

<table>
<thead>
<tr>
<th>Image input format</th>
<th>Possible export formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>JPEG, TIFF (8-bit)</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIFF (8- or 16-bit, depending on the input image)</td>
</tr>
<tr>
<td>RAW</td>
<td>JPEG, TIFF (8- or 16-bit), DNG</td>
</tr>
</tbody>
</table>

### 4.3.3. Creating an export option

**Creating and activating an export option**

To create a new export option, click the Add (or +) button on the bottom left of the export options floating window to select from the options in a drop-down menu. You can rename your selection and adjust its parameters as you wish. Make your other choices according to your needs. Some settings are dependent on the type of output file (see below); other settings are typical, such as choosing the destination folder, the suffix for the file name, and parameters for scaling.

**Export destination**

By default, the destination folder is the same folder in which the original or source image is found. This choice is indicated in the Destination drop-down menu as one of the output options. If you select the Custom folder option, a dialogue window will open that will allow you to choose a folder on your hard drive, or to create a new folder.
Note that the pathway can be either absolute (as in, for example, "C:\Photos\Sorties DxO Optics Pro") or relative (DxO Optics Pro
outputs). In the first case, all the images will be saved in one single destination folder, even if the source images are scattered
among several different folders. In the second case, the images will be saved in a sub-folder within the source folder, which will
allow you to keep the corrected images close to the originals. In this situation, there will be as many sub-folders created as there
are source folders.

### NOTE

All of the following options described below can be accessed by selecting **Advanced settings** in the export options floating
window.

#### Suffix

By default, DxO Optics Pro appends "_.DxO" to any file name. You can replace this with any sequence of characters.

#### Resizing

Changing the size of an image involves the process known as “resampling”, which requires recalculating the number of pixels that
make up the image. In all cases, resampling must be performed at the latest possible stage, since it destroys a certain amount of
information in your image. Therefore, if you will need to do subsequent post-processing, we advise you to keep the initial image size.

If you activate the **Resize image** option, you will have to choose among the following parameters:

- **The maximum dimension of the output image** (whether by height or width) in pixels, centimeters, or inches. One single
dimension is enough for the program to maintain the aspect ratio (the proportions) of the image.
- **The resolution**, which can be reset without having to perform resampling.
- **The interpolation method**: Several options are available: Auto is a good choice, but many photographers are loyal supporters
  of bicubic interpolation for optimum precision, and DxO Optics Pro offers a bicubic interpolation sharper option.

#### ICC Profile

The **ICC Profile** (not available for DNG outputs) can be the original profile, or a choice among sRGB, AdobeRGB, or a custom profile.
In practice, the sRGB profile is well suited for web publishing and for printing on photographic or ink-jet printers. The AdobeRGB
profile is generally better for images that need retouching (e.g., for publication), but in this case, TIFF output is preferable to JPEG.
A custom profile is a good choice for a printer for which you have an ICC profile stored.

#### Output formats

The next step is to select the proper settings for the various output file formats. These formats are JPEG, TIFF (8- and 16-bit), and DNG.

**JPEG**

The JPEG format is for files that are going to be printed in photo labs, displayed online, or sent by email. DxO Optics Pro requires
you to set the quality level when processing JPEG files. A slider lets you to set the degree of compression, and thus quality loss,
from 0 to 100. Of course, the higher the quality, the larger the output file. Since JPEG is a lossy format, we advise choosing a higher
quality setting (e.g., 90) and compensating if necessary by using a smaller image size. This is a better compromise than a larger
image with a lower-quality setting.

**TIFF**

The TIFF format is a lossless format designed for high-quality files that you intend to archive or which you will post-process further
(all image editing applications can import TIFF images). When you choose TIFF format for an output image, you must also choose
two specific settings:

- **The compressed / uncompressed option**: We advise sticking with the uncompressed option, which results in a larger file, but
  is more widely accepted by post-processing programs than compressed TIFFs.
- **8- or 16-bit encoding**: 8-bit encoding provides only 255 possible levels per color channel, while 16-bit encoding provides
  65,536 shades of color. This choice is only available if the source image itself was originally coded in a 16-bit format (i.e., RAW
  or 16-bit TIFF format). We advise choosing the 16-bit format whenever possible, since it greatly improves color rendition.
  Furthermore, this format represents an excellent choice for preserving and archiving your images.
**DNG**

The DNG format is designed for files that you intend to archive or that are going to undergo further post-processing with DNG-compatible software such as Adobe Camera Raw/Photoshop/Lightroom. The DNG generated by DxO Optics Pro is a 16-bit linear DNG format, which is only available for original images shot in RAW.

With linear DNG, the three color channels have been individually calculated, which means that the file is three times larger than the original RAW file. This format offers the same level of color and exposure control as a camera-generated RAW file.

For the other options, you can treat DNG files in the same way as TIFF files — except for image size, as files intended for archiving and/or further post-processing should not be resized (so as to maintain maximum potential).

### 4.3.4. Export to Disk

**Export to Disk** is how you process and save your corrected images to your computer’s hard drive or peripheral drive. Before starting the export, you must check the boxes in the **Export to Disk – Options** window to enable the desired output options (even if you just create a new output option, it will be disabled by default). You must enable at least one option, but you can also activate as many as you want. This is one of the key features of DxO Optics Pro, which allows you to simultaneously export multiple different files from the same source image.

**TIP**

The export options let you create backup copies: all you have to do is give the same name to an image but select a different place to store it on your disk or save it on a different server.

To begin processing and exporting images in the **Image Bowser**, simply click on the **Export to Disk** button in the **Image Browser** command bar or choose it from the adjacent export drop-down window. If an exported image has the same name as another image in the destination folder, the program will ask if you want to overwrite it. If you choose no, the image will not be exported.

**NOTE**

You can have DxO Optics Pro add a special suffix to the names of your processed files [see Export Options].

While the export is underway, a gear icon is displayed in the upper right corner of the thumbnails in the Image Browser, while a tiny overall progress bar is displayed in the **Export** button itself. You can access a larger version of the progression bar by clicking on the **Export** button, which opens the **Progress** palette.

**NOTE**

The processing time will vary according to the size and number of images you export.

When processing is complete:

- A confirmation message will appear.
- The blue star in the upper right corner of the thumbnails will be replaced by a green checkmark that confirms that the operation was successful.
- If an error occurs, an exclamation point will appear.

You can change the number of images that can be processed simultaneously by going to **Preferences > Performance > Display and processing** (Microsoft Windows).

**NOTE**

DxO Optics Pro uses all of your computer’s core processors to process one or several images. However, if you increase the number of images you want to process, make sure that you have enough RAM available so that you can take full advantage of your processors, rather than risking being slowed down because of the rate of data exchange between the RAM and the hard drive.
You can export your images to other applications (such as Photoshop, Lightroom, etc.) to perform additional corrections. To do so:

1. Select the images to export in the Image Browser.
2. Open the drop-down menu immediately to the right of the Export to disk button and then select Export to application.
3. A dialogue box will open that will let you choose the external application from your operating system’s Applications folder.
4. After selecting the external application, choose from among the following options in the Action menu: Process as JPEG, TIFF, or DNG and Export, or export selected files without processing.
5. Depending on the format you choose, select other relevant options (e.g., JPEG quality level, 8- or 16-bit TIFF, ICC profile, etc.).
6. Click on Export: your file is processed and will open in the designated application.

**NOTE**

In Microsoft Windows, after the first time you export an image to an external application, that application will be included as an option in the Export drop-down list the next time you use DxO Optics Pro 9. (You will need to select the application every time in OS X.)

**NOTE**

If you choose one or more RAW files to export and then also choose the Export selected file(s) without processing option, the destination application will not display the rendering nor any of the corrections you have made in DxO Optics Pro.

### 4.5. Workflow with Lightroom

#### 4.5.1 About workflow with Lightroom

DxO Optics Pro offers you an integrated and nondestructive workflow with Lightroom, allowing you to transfer your RAW-format images from the Lightroom cataloguer to DxO Optics Pro for processing, and then send the processed photos back into Lightroom.

**NOTE**

This feature is compatible with Lightroom 3, 4, and 5.

This workflow consists of two components:

1. A Lightroom plugin that lets you directly transfer your RAW images into DxO Optics Pro.
2. An Export to Lightroom feature in DxO Optics Pro that lets you export the processed RAW files in different output formats.

**NOTE**

DxO Optics Pro automatically installs the plugin in the list of Lightroom plugins. In the event that the installation does not occur correctly, or if you have previously refused to install the plugin, or if you installed Lightroom after installing DxO Optics Pro on your computer, you can still launch the plugin installation by clicking on Export to Lightroom in DxO Optics Pro.
### 4.5.2 Transfer an image from Lightroom to DxO Optics Pro

To transfer an image from Lightroom to DxO Optics Pro:

1. After you have selected your worklist in Lightroom, click on the images in the Filmstrip that you want to export.
2. Select **DxO Optics Pro 9** from the File > Plugin – Extras > menu.
3. DxO Optics Pro launches and creates a project which contains the images that you exported.
4. Start processing your images.

**IMPORTANT** - The corrections that you have made to your RAW images in Lightroom are not transferred with those images into DxO Optics Pro.

---

**ASTUCE**

At the end of the transfer, DxO Optics Pro automatically displays the Customize tab, the created project, and the Export to Lightroom button, so you can immediately start processing your images.

---

### 4.5.3 Export an image from DxO Optics Pro to Lightroom

1. After you have finished processing your images, select them in the Image browser.
2. Click on the Export to Lightroom button.
3. A dialog box will open
4. In the Action menu, choose the file format: process as JPEG, TIFF, or DNG.
5. If necessary, choose the ICC profile to attach in the Advanced settings menu.
6. Click on Export.

**NOTE**

If you want to make further changes to your images in Lightroom, we recommend that you select the DNG raw format, which will provide you with a range of corrections similar to those for RAW files. Otherwise, select either JPEG or TIFF format.

The images exported to Lightroom are gathered together in a collection whose name includes the date and time of export. An ensemble of DxO Optics Pro collections is created to keep all such processed collections together.

Processed files are visible in the Lightroom filmstrip in file system mode, and are associated with the corresponding stack of original RAW images.

**NOTE**

If you have assigned stars or colors or have associated keywords with your RAW images in the Lightroom Library, they will not be visible in DxO Optics Pro, but they will be preserved and will be visible again after you have transferred the images back into Lightroom. To preserve the rankings, check the “Automatically write changes into XMP” option in the Edit > Catalog Settings menu in Lightroom. The “Preserve XMP metadata in sidecars for RAW images” option must also be checked in the Preferences > General tab in DxO Optics Pro.

**NOTE**

You can repeat the procedure by selecting the original RAW images in Lightroom: DxO Optics Pro will preserve the corrections that you have made to your images. If you overwrite the output file, any additional corrections performed in Lightroom will also be preserved.
### 4.6. Export to Facebook

To export your images to Facebook:

1. Select one or more images in the **Image Browser**.
2. Click on the arrow to the right of the **Export** button and then choose **Export to Facebook**.
3. In the **Options** floating window, connect to your Facebook account.
4. If you have several albums in your Facebook account, pick the one you want in the **Album** drop-down window.
5. In the **Action** drop-down menu of the **Processing options** (Microsoft Windows) or the **Format** section (OS X), choose **Process as JPEG and Export**.

**NOTE**

If you are exporting JPEG images that you have already processed, you can also select **Export without processing selected file(s)**. Be aware that Facebook accepts only JPEG-formatted images.

6. Use the **Quality** slider to adjust the JPEG compression.

7. You can resize your image(s) in the **Advanced settings** (Microsoft Windows) or **Resize** section (OS X) by clicking on the **Allow image resampling** checkbox, entering a value in the **Largest size** dimension field, and then choosing an interpolation method (**Auto** by default).

**NOTE**

Facebook automatically resizes images to 2048 pixels unless you select a smaller size, in which case the size you specify will be applied to your image(s).

8. Click on **Export**: DxO Optics Pro launches the processing as well as the export. A progress bar will display next to the progress button in the **Source browser** command bar.

9. As soon as the export is finished, check your Facebook page and the selected album. You can go there directly by clicking on the progress button, which will open the **Export** progress window, and then by clicking on loupe located at the right of the relevant progress bar.
4.7. Export to Flickr

After you have clicked on the arrow to the right of the Export button for the first time and then chosen Export to Flickr in the drop-down menu, a floating window will prompt you to connect to Flickr.

1. Click on Connect.
2. Your default web browser will launch.
3. On the Yahoo Flickr home page, enter your user ID and password.
4. The next pages you see will ask you to authorize DxO Optics Pro to access your Flickr account by providing a confirmation code.
5. Return to the DxO Optics Pro interface, and enter the confirmation code.
6. A window will confirm that the authorization has been approved.

To export your images to your Flickr gallery:

1. Select one or more images in the Image Browser.
2. Select Export to Flickr mode.
3. In the floating window, connect to your Flickr account.
4. In Export to Flickr – Options, select the batch of photos and enter the tags you want. Also choose if you want your images to be public or private.
5. Select the export method from among the “Process as” options:
   - RAW files: Process as JPEG and export.
   - TIFF or JPEG files: Process as JPEG or Export without processing the selected file(s).
6. Use the Quality slider to set the JPEG compression.
7. Click on Enable resizing from among the Resize options, enter a value in the Largest Size field, and select an Interpolation method (Auto by default).
8. Click on Export: DxO Optics Pro launches image processing and then export. A progress bar is displayed in the Image Browser command bar to the left of the Print command icon on the right side.
9. As soon as the transfer is completed, check your Flickr page.

NOTE

In contrast to previous versions of DxO Optics Pro, it is no longer necessary to process your images before exporting them to your Flickr gallery.
5.1. Printing (Microsoft Windows)

5.1.1. About the Print module

The print module lets you print any of the file types supported by DxO Optics Pro, including RAW files and virtual copies, before or after processing. It is not necessary to export images in order to print them, and the print module can be called from either the **Organize** or the **Customize** tab.

The print module automatically lists every printer connected to your computer, including virtual PDF printers.

Color management is handled either by the printer driver or by DxO Optics Pro, with the latter giving you the option of choosing an ICC profile and adjusting the rendering and print sharpness.

5.1.2. Tools and settings

**Interface**

After selecting one or several images, the print module can be called as follows:

- By clicking on the **Print selected images** button in the Image Browser command bar.
- By selecting **Print selected images** from the File menu.

A large floating window appears on top of the DxO Optics Pro Viewer pane. It is divided in two sections:

- A **print preview area** on the left that displays the images and pages to be printed (use the arrows to navigate through the different items).
- A **settings column** on the right side that contains all the printer controls and adjustments.

In the bottom corner of the Print module window, you will find the **Print** button (which opens a floating print progress bar) and the **Cancel** button.


**Settings**

**Printer parameters**

The first palette is devoted to the printer:

- **Name**: The drop-down list shows all the printers installed and connected to your computer. Select the printer you want to use (if you do not want to use the preselected default printer).
- **Paper size**: Shows the paper size per the printer driver.
- **Orientation**: Shows the portrait or landscape orientation per the printer driver.
- **Resolution**: Shows the default resolution (300 dpi) per the printer driver, and allows you to select another resolution if desired.

![NOTE]

The maximum print resolution is 1200 dpi.

**Color and sharpness**

The **Color and sharpness** palette lets you manage the print colors in two ways: either through the printer driver, or by selecting an ICC profile and rendering mode yourself via the **Color profile** drop-down menu. You can also adjust the print sharpness by using a dedicated slider.

**Color management by the printer**

As soon as the printer parameters have been set (see the paragraph on Printer settings above), no further intervention on your part of the user is necessary, since the printer driver manages the colors during printing.

![NOTE]

The following rendering modes will appear as soon as you choose an ICC profile in **Color management by DxO Optics Pro** mode.

**Color management by DxO Optics Pro**

Selecting this mode displays the following menus:

- **Import ICC profiles**: A dialogue box lets you select directly from among the folder containing the ICC profiles installed on your computer.
- **Rendering mode**: This menu lets you choose from among four colorimetric rendering modes:
  - **Perceptual**: This mode compresses the gamut and modifies all colors so that they are printable. This is the rendering that is best for printing photographs.
  - **Saturation**: This mode ensures color matching between the source color space and the target color space. It is best suited for emphasizing brilliant colors.
  - **Relative colorimetry**: This mode lets you preserve colors as faithfully as possible (particularly important when dealing with a logo or trademark, etc.), but in contrast to absolute colorimetry mode below, the source space white is converted to the target space white.
  - **Absolute colorimetry**: This mode also lets you faithfully preserve colors, but unlike the Relative colorimetry mode above, the source white space remains unchanged.

![NOTE]

When color management is provided by DxO Optics Pro, you must ensure that the color options in the printer driver are disabled (a warning message is displayed in the palette).

**The Sharpness slider**

The **Sharpness** slider lets you reinforce the sharpness of your images when you print them. The slider is set by default to 50 on a scale of 100.
Sharpening adapts automatically to the size of the print, but you can still use the slider to adjust the sharpness to suit your tastes and the size of the prints.

On-screen previewing of sharpness enhancement is not possible. We advise you to experiment with paper tests to determine the settings that work best for your photos, according to your personal tastes.

**Layout**
The Layout palette lets you create contact sheets by using the **Rows** and **Columns** sliders or by entering the number of rows and columns desired in the appropriate fields. There are also two optional checkboxes:
- **Crop to fill**: When checked, the image will fill the page (and may end up being cropped).
- **Rotate to fit**: When checked, the print module will rotate the image in order to fill the page.

**Margins**
The margin sliders let you adjust the margin sizes on the page perimeter. You can select the measurement units (centimeters, inches, etc.) in the drop-down menu.

**Cell size**
The **Height** and **Width** sliders let you make the following changes so you can adapt the page or pages to the content that you want to print:
- **Single image**: One lone image on the page is a cell by itself; use the height and width slider to move the image horizontally and/or vertically.
- **Multiple images or contact sheets**: Use the sliders to modify the size of the image cells as well as the spacing between the cells, both horizontally and vertically.

**Image caption**
You can add captions to and position them on your images, and then choose the font type, size, etc.

The **Caption** drop-down menu has four options:
- **None** (i.e., no caption).
- **Image name** (basically, the file name).
- **Image name and date**.
- **Image name and metadata** (which includes the shutter speed, aperture value, and focal length and ISO value, etc.).

The **Position** drop-down menu lets you position the caption below, above, or on the left or right side of the image.

The **Font** settings let you choose any font type, size, style, effect, and color available on your computer (a system window will open for that purpose).

**TIP**
The settings are saved when you quit the print module. If you want to set up a different layout or change other settings, you will need to reset the sliders one by one by double-clicking on each one.
5.2. Printing (OS X)

5.2.1. Tools and settings

**Interface**

The print menu uses the operating system interface. After selecting one or more images, you can print from either tab as follows:

- By clicking on the **Print selected images** button in the **Image Browser** command bar.
- By selecting **Print selected images** from the **File** menu.

A large floating window will appear on top of the DxO Optics Pro Viewer pane. It is divided in two sections:

- A print preview area on the left that displays the images and pages to be printed (use the arrows to navigate through the different items).
- A settings column on the right side that contains all the printer controls and adjustments.

In the bottom corner of the Print module window, you will find the **Print** button (which opens a floating print progress bar) and the **Cancel** button.

**Settings**

**Printer parameters**

The first two drop-down menus on the upper right are devoted to the printer:

- **Printer**: The drop-down list shows all the printers installed and connected to your computer that you can use to print your photos.
- **Presets**: This menu lets you save and then choose your printing configurations.

A third drop-down menu in the center offers image settings for DxO Optics Pro and for the printer driver [see below]. (If you do not see this third menu, click on the **Show Details** button in the lower left of the print window.)

**DxO – Image parameters**

- **Crop to fill**: When checked, the image will fill the page (and may end up being cropped).
- **Rotate to fit**: When checked, the print module will rotate the image in order to fill the page.
- **Add caption**: Lets you add and place a caption as well as choose a font and style.
There are three caption options:

- **Image name**: the file name.
- **Image name and metadata** (which includes the shutter speed, aperture value, and focal length and ISO value, etc.).
- **Image name and date**.

The **Position** drop-down menu lets you position the caption below, above, or on the left or right side of the image. The **Font** menu lets you choose any font type, size, style, effect, and color available on your computer (a system window will open for that purpose).

**DxO – Layout**

**Margins**
Enter the margin dimensions for the page (top, bottom, sides).

**Layout**
The sliders let you adjust the number of rows and columns (especially useful for creating contact sheets).

**Cell Size**
You can specify the size of the cells by entering values, or by using the Auto mode. In the latter case, all available space will be used.

**Other settings**
All other parameters, such as type of paper, paper size, orientation, etc., are set in the printer driver, accessible via the central drop-down menu.

**NOTE**

The maximum print resolution is 1200 dpi.

**DxO – Sharpness**

The **Sharpness** slider lets you reinforce the sharpness of your images when you print them. The slider is set by default to 50 on a scale of 100.

**NOTE**

Sharpening adapts automatically to the size of the print, but you can still use the slider to adjust the sharpness to suit your tastes and the size of the prints.

On-screen previewing of sharpness enhancement is not possible. We advise you to experiment with paper tests to determine the settings that work best for your photos, according to your personal tastes.
6.1. Menus

File menu

- **New Project**: Creates a new DxO Optics Pro project.
- **Open Project**: Opens a project stored in the DxO Optics Pro database.
- **Recent Locations**: Gives direct access to recently-created or opened projects.
- **DxO Optics Pro database**: Allows you to create a backup of the database or to restore a backup from the database.
- **Export image for ICC profile**: Saves images that can be used by professional calibration programs to create ICC profiles (linear RAW or realistic color rendering options are available).
- **Sidecars**: Exports the individual settings file of the selected images to the same directory as the original images, or imports the sidecars of currently-selected images from the same directory as the original images (the individual settings file for each image in .dop format). Sidecars allow you to transfer all correction settings of an image from one computer to another or share them with other users. Note that Mac and PC sidecars are compatible with one another.
- **Export to Disk**: Lets you export your images to the hard drive of your computer or to a peripheral drive.
- **Export to Application**: Lets you export images (original or processed) to an external application.
- **Export to Facebook**: Exports your images to your Facebook timeline.
- **Export to Flickr**: Exports your images to your online Flickr gallery.
- **Print**: Opens the print module.
- **Exit**: Closes DxO Optics Pro.

Edit menu

- **Undo and Redo**: Each command affects the last action performed.
- **Select All**: Lets you select all the images displayed in the Image Browser.
- **Rename file**: Lets you rename the selected image file (the change is also saved to your hard drive).
- **Preferences**: Lets you customize the software (see the Preferences section below for more details about specific options).

View menu

The upper section of the **View** menu lets you move from one tab to the other, and the lower section controls the way in which images are displayed in the Viewer.

**NOTE**

Some of the following commands can be either active or inactive, depending on the tab you are in.

The lower part is divided into four sections:

- **Image information overlay**: Displays a floating window containing various information about the selected image.
- **Grid overlay** (Customize tab): Displays the Grid overlay in the Viewer.
- **Refresh**: Refreshes the display of the selected folder or project in the Image Browser.
- **Show/Hide Source Browser** (Organize tab): Lets you hide or display the pane that contains your folders and projects.
- **Show/Hide Image Browser**: Lets you hide or display the Image Browser — that is, the row of image thumbnails located on the bottom of the application window.
- **Show/Hide all palettes** (Customize tab): Lets you show or hide all the correction palettes in one go.
- **Full screen**: Lets you pass to full-screen display mode and return to regular display mode.
- **Dock/Undock Image Browser**: Lets you dock the Image Browser to the bottom of the screen or lets you undock it and move it elsewhere as a floating window.
**Image menu**

- **Apply Preset**: Lets you select a preset from the drop-down menu and apply it to the selected image.
- **Create preset from current settings**: Lets you create a preset based on the current correction settings for the selected image.
- **Copy Correction Settings**: Lets you copy the settings of the current image to apply them to another image or batch of images.
- **Paste Correction Settings**: Once you have selected a new image, this command lets you paste the settings that you have previously copied.
- **Resolve DxO Optics Module ambiguities**: A dialog box opens that will let you manually resolve any ambiguities with respect to which DxO Optics Module should be used.
- **Rotation**: Lets you rotate the image 90° to the left or right.
- **Display input image in Windows Explorer**: Lets you see the location in the system of the selected input file.
- **Display output image in Windows Explorer**: Lets you see the location in the system of the selected output file.
- **Open input image/output image with**: Lets you open a source image or output image in a third-party application. When you first use this option, the Browse command will display that will let you choose the application you want to use.
- **Create Virtual Copy**: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).
- **Create project from current selection**: Lets you create a new project from images you select in the Image Browser.
- **Add current selection to project**: Allows you to add images you select in the Image Browser to an existing project.
- **Remove**: This command behaves differently depending on the situation:
  - In a project, the selected image will be removed from it (but not moved to the trash).
  - In a folder without virtual copies, the image is moved to the trash.
  - In a folder containing virtual copies which are all selected, moves all selected files to the trash.
  - In a folder containing virtual copies which are not all selected, removes only the virtual copies (including from the associated projects).
- **Authorize processing**: Lets you apply a processing status to a selected image (No, Maybe, Yes). Depending on your choice, a red, yellow, or green flag will be displayed on the image thumbnail. (Visible only if you have selected this option in the Display window in Preferences.)
- **Ranking**: Allows you to rank images by quality using a star rating system. (Visible if the Ranking stars option has been activated in Preferences.)
- **Image properties**: Displays a floating window with a certain amount of information about the selected image (e.g., name, pathway, EXIF data, associated DxO Optics Module, etc.)

**DxO Optics Modules menu**

This menu lets you manage the DxO Optics Modules that are indispensable for a completely automatic processing of your images:

- **Download new DxO Optics Modules** (Internet connection required): Lets you connect to the DxO Labs server to download any DxO Optics Modules that have not been previously installed on your computer. The Optics Modules will be operational as soon as they are downloaded.
- **Installed DxO Optics Modules**: Displays the list of Optics Modules already installed, and lets you uninstall any Optics Module that is not currently in use.
- **DxO Optics Modules Roadmap** (Internet connection required): Connects you to a page on the DxO Labs website containing a list of supported and planned DxO Optics Pro Modules (you can find the planned Modules in the list by clicking on the Available column header).
- **Suggest a DxO Optics Module to DxO Labs** (Internet connection required): Connects you to a form on the DxO Labs website on which you can suggest a DxO Optics Module for DxO Labs to produce.
Palettes menu (Customize tab)

This menu lets you manage the tool palettes in the Customize tab:

- **Hide/show palettes**: You can check or uncheck the palettes in the list that you want to hide or show.
- **Create a user palette**: Lets you create a custom palette into which you can add the palettes of your choice. A dialog box lets you enter a name for the new palette.
- **Hide/show all palettes**: Lets you hide or display all of the palettes in one go.

Workspace menu (Customize tab)

This menu lets you create and select a workspace:

- **DxO Standard**: The default workspace selection.
- **User workspace(s)**: One or more custom workspaces that you can select from a list (the name or names will appear in the menu; see below).
- **Save workspace**: Lets you save a custom workspace (a dialogue box will prompt you to enter a name for the workspace and to validate it).
- **Delete workspace**: Lets you delete the selected (active) workspace.

Help menu

The Help menu contains several different sources of help and information about how to best use DxO Optics Pro:

- **DxO Optics Pro Help**: Launches the online User Guide.
- **Online help and resources** (Internet connection required): Opens DxO online help.
- **DxO Academy** (Internet connection required): Takes you to the home page of the DxO Academy, where you can find tutorials, webinars, and downloadable DxO software user guides.
- **Keyboard shortcuts**: Displays a list of keyboard shortcuts.
- **Search for updates** (Internet connection required): If you select this option, the application will contact the DxO Labs server to check if you have the very latest version of the program installed on your computer. If this is not the case, a dialog box will offer you the possibility of downloading and installing the latest version.
- **DxO FilmPack**: Lets you select and activate the relevant version of DxO FilmPack. (After a 30-day free trial, you must own a DxO FilmPack license to keep using its tools and features.)
- **Visit web site** (Internet connection required): Launches your default web browser and connects you to the home page on the DxO Labs website.
- **About DxO Optics Pro**: Displays the About DxO Optics Pro window, where you will find information about the version you are using and any add-ons currently installed. This information is especially useful if you need to contact DxO Labs technical support.

Right-click

The right-click menu in the Image Browser and the Viewer (accessible from both the Organize and Customize tabs):

- **Export to Disk**: Lets you export your images to the hard drive of your computer or to a peripheral drive.
- **Export to Application**: Lets you export images to an external application.
- **Export to Facebook**: Exports your images to your Facebook timeline.
- **Export to Flickr**: Exports your images to your online Flickr gallery.
- **Print**: Opens the print module.
- **Download DxO Optics Modules** (Internet connection required): Lets you download any DxO Optics Modules that have not been previously installed on your computer. The Optics Modules will be operational as soon as they are downloaded.
- **Resolve DxO Optics Module ambiguities**: A dialog box opens that will let you manually resolve any ambiguities with respect to which DxO Optics Module should be used.
- **Apply Preset**: Lets you select a preset from the drop-down menu and apply it to the selected image.
- **Create preset from current settings**: Lets you create a preset based on the current correction settings for the selected image.
- **Copy Correction Settings**: Lets you copy the settings of the current image to apply them to another image or batch of images.
• **Paste Correction Settings**: Once you have selected a new image, this command lets you paste the settings that you have previously copied.

• **Create project from current selection**: Lets you create a new project from images you select in the Image Browser.

• **Add current selection to project**: Allows you to add images you select in the Image Browser to an existing project.

• **Rename file**: Lets you rename the selected image file.

• **Remove**: This command behaves differently depending on the situation:
  - In a project, the selected image will be removed from it (but not moved to the trash).
  - In a folder without virtual copies, the image is moved to the trash.
  - In a folder containing virtual copies which are all selected, moves all selected files to the trash.
  - In a folder containing virtual copies which are not all selected, removes only the virtual copies (including from the associated projects).

• **Rotation**: Lets you rotate the image 90° to the left or right.

• **Load original image file folder**: In a project, this command lets you access an image file in its original folder.

• **Display input image in Windows Explorer**: Lets you see the location in the system of the selected input file in the Source Browser.

• **Display output image in Windows Explorer**: Lets you see the location in the system of the selected output file.

• **Open input image/output image with**: Lets you open a source image or output image to a third-party application. When you first use this option, the Browse command will display a window that will let you choose the application you want to use.

• **Create Virtual Copy**: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).

• **Authorize processing**: Lets you apply a processing status to a selected image (No, Maybe, Yes). Depending on your choice, a red, yellow, or green flag will be displayed on the image thumbnail. (Visible only if you have selected this option in the Display window in Preferences.)

• **Ranking**: Allows you to rank images by quality using a star-rating system. (Visible if the “Ranking stars” option has been activated in Preferences).

• **Image properties**: Displays a floating window with a certain amount of information about the selected image (e.g., name, pathway, EXIF data, associated DxO Optics Module, etc.).

### 6.2. Preferences

The Preferences are accessible in the **Edit>Preferences** menu. The Preferences window includes three tabs.

**General tab**

The **General** tab is organized in the following manner:

**Application preferences**

- **Application language** lets you choose the UI language (requires restarting DxO Optics Pro).

- **Automatically check for updates** (you must restart DxO Optics Pro if you activate or deactivate this option).

- **Agreement to participate or not in an anonymous product improvement program by DxO**. This program sends a limited set of technical data about your system configuration and about your DxO projects to DxO Labs. This helps DxO enhance its products and improve your experience. [Click on the Product improvement program link in the tab for more details.]

**Processing**

- **Use legacy (v2.0 and earlier) FilmPack color handling**: If you own and DxO FilmPack v3.0 (and higher), this setting lets you use the color renderings of DxO FilmPack v2.0 (and earlier versions). Relaunching the application is required.

- **Preserve metadata in XMP sidecars for RAW images**: Allows the application to process and export your RAW images while using metadata previously stored in an xmp-format file alongside the input image (e.g., metadata created by a program such as Adobe Bridge).
Correction settings

- **Automatically export sidecar settings (.dop):** Settings files (or sidecars) are small text files associated with an image whose names include the extension “.dop”. They contain information for correcting images. If you want to transfer images to another computer using DxO Optics Pro, you can also transfer their sidecars settings. That way, when you add these images to your project (after checking that automatic loading is enabled on the other computer - see below), the corrections made on the original computer will show up on the destination computer. Note that you can also upload files to Settings via the File > Sidecars > Import menu.

- **Automatically import sidecars (.dop):** You can automatically include any existing sidecar information associated with image files that you download from another source.

- **Default preset for new RAW images:** Lets you select a default preset that will be applied to all RAW images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.

- **Default preset for new RGB images:** Lets you select a default preset that will be applied to all RGB (JPEG, TIFF, DNG) images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.

**DxO Optics Pro database**

- **Location:** Indicates the pathway for accessing the DxO Optics Pro database. If you click on Browser, a dialog box will show you where this is located in the system.

**Display tab**

The Display tab is composed of three parts: choices that are common to different stages in image processing (General), and others which are specific to the Customize tab or to the Image Browser.

**General**

- **The ICC profile used for display** menu gives you three options for entering the ICC profile of your screen:
  - The current profile of the display device, if you have calibrated it with a colorimeter.
  - The generic profile sRGB [use this option if in doubt].
  - The Adobe RGB profile, to use only with a high-quality screen for which you know the specific Adobe RGB range.

- **Background window color:** This slider allows you to lighten or darken (white to black) the Viewer, which is the principal window for displaying and working on images. This setting does not affect other panels. To return to the default setting, double-click on the slider.

- **Two activate/deactivate options:**
  - Display DxO Optics Module download window when images are found for which no DxO Optics module has been loaded
  - Display missing/ambiguous DxO Optics Modules dialog box before processing

**Customize tab**

**Overlay grid size** lets you adjust the size of the grid overlay, which can be positioned over the image to help you deal with distortion or perspective problems.

**Image Browser section**

You can choose among the following six display options for each thumbnail: Always ON, Always OFF, and On mouseover.

- **Image processing status** indicates if a file is waiting for processing, processed, etc.
- **Image name** shows if the image is a RAW or RGB-type file.
- **Allow Processing** displays red/yellow/green lights showing which images can and cannot be processed.
- **Ranking stars** let you grade the quality of your images.
- **DxO Optics Module status** shows if a DxO Optics Module is available or not.
- **The Delete** button lets you remove an image from the project or hard drive.
**Performance tab**

**Cache**

The buffer, also commonly referred to as the **cache**, is the embedded memory your computer uses to store DxO Optics Pro previews and thumbnails. Increasing the cache size, especially if you regularly treat a large number of photos, improves the performance of DxO Optics Pro. In this section, in addition to the cache size, you can determine where the cache storage folder should be located by using the Browse button. You can also empty the contents of the cache by using the Clear button.

**NOTE**

You can see the current size of the cache by hovering over the cache slider with your cursor.

**Display and processing**

- **GPU acceleration** lets you make use of the graphics card (GPU) to speed up the display. You should disable this control if it causes your display to be unstable.

- **OpenCL** improves not only the thumbnail display, but you can take advantage of computing power for image processing. When you first start DxO Optics Pro, a performance test will determine if the graphics card (GPU) is faster than the processor (CPU). If the CPU is faster, OpenCL will be grayed out and inaccessible.

- You can prevent DxO Optics Pro from displaying a preview of noise reduction when the zoom value is 75%. The preview is disabled by default [when activated, the responsiveness of the application can be reduced, depending on how powerful your computer is].

- By default, the number of images that you can process at the same time is 2, but if your computer is sufficiently powerful, you can increase this number.
7.1. Menus

**DxO Optics Pro 9 (application) menu**

- **About DxO Optics Pro**: Displays the About DxO Optics Pro window, where you will find information about the version you are using and any add-ons currently installed. This information is especially useful if you need to contact DxO Labs technical support.
- **Activate DxO Optics Pro**
- **DxO FilmPack**: If DxO Optics Pro is activated, you can use this command to install DxO FilmPack as an integral part of DxO Optics Pro (following the month-long free trial, a DxO FilmPack license is required). Once activated, the DxO FilmPack controls will show up in a dedicated palette in the Correction pane.
- **Check for updates**
- **Preferences**: Opens the Preferences window.
- **Hide DxO Optics Pro**
- **Hide Others**
- **Show All**
- **Quit DxO Optics Pro**

**File menu**

- **New Project**: Creates a new DxO Optics Pro project.
- **Open Project**: Opens a project stored in the DxO Optics Pro database.
- **Recent Projects**: Gives direct access to recently-created or opened projects.
- **Close Window**
- **Project database**: Allows you to create a backup of the database or to restore a backup of the DxO database.
- **Sidecars**: Exports the sidecars of the selected images to the same directory as the original images, or imports the sidecars of currently-selected images from the same directory as the original images (the individual settings file for each image) in .dop format. Sidecars allow you to transfer all correction settings of an image from one computer to another or share them with other users.
- **Print**: Opens the print menu.

**Edit menu**

- **Undo and Redo**: Each command affects the last action performed.
- **Cut**: Lets you cut out selected text or objects from their current location and put them into the system clipboard.
- **Copy**: Lets you copy selected text or objects and place them in the system clipboard. The original text or objects remain at their current location.
- **Paste**: Lets you copy the content of the system clipboard to the current cursor position (for example, personal details to be added into the image EXIF field).
- **Select All**: Lets you select all the images displayed in the Image Browser.

**View menu**

The **View** menu lets you move from one tab to the other and controls the way in which images are displayed in the Viewer.

**NOTE**

Some of the following commands can be either active or inactive, depending on the tab you are in.
- The first part of the menu lets you move from either the Organize or Customize tab to the other.
- **Show/Hide Source Browser** (Organize tab): Lets you hide or display the pane that contains your folders and projects.
- **Display original and corrected images side-by-side** (both tabs): Lets you compare the effects of your settings and corrections to the original image.
- **Reference image** (both tabs): Lets you designate the reference image according to the following criteria: As shot [default], No Output, No Virtual Copy.
- **Show/Hide Image Information overlay** (both tabs): Hides or displays the information overlays provided by DxO Optics Pro (Correction Preview, Original, etc.).
- **Show/Hide Grid overlay** (both tabs): Displays or hides a grid on top of the image displayed in the Viewer.
- **Zoom in / Zoom out** (both tabs): Zooms into the image and back out.
- **Fit to screen** (both tabs): Displays the full image in the Viewer.
- **Full size** (both tabs): Displays the image at 100%.
- **Show Highlight clipping** (both tabs): An overlay mask indicates the clipped highlight values in the image.
- **Show Shadow clipping** (both tabs): An overlay mask indicates the clipped dark values in the image.
- **Palette** (Customize tab): This menu allows you to hide or show correction palettes, and to create new palettes.
- **Workspaces** (Customize tab): This hierarchical menu lets you switch between the Standard workspace and your own custom workspace, and to save or delete a custom workspace.
- **Docks** (Customize tab): Hides or displays the lateral panes.
- **Dock/Undock Image Browser** (both tabs): Lets you dock the Image Browser on the bottom of the screen or lets you undock it and move it elsewhere as a floating window.

**Image menu**

**NOTE**

The contents of the Image menu is identical to the Image Browser right-click menu.

- **Apply Preset**: Lets you select a preset from the drop-down menu and apply it to the selected image.
- **Create preset from current settings**: Lets you create a preset based on the current correction settings for the selected image.
- **Import Preset**: Allows you to import a customized preset.
- **Copy Correction Settings**: Lets you copy the settings of the current image to apply them to another image or batch of images.
- **Paste Correction Settings**: Once you have selected a new image, this command lets you paste the settings that you have previously copied.
- **Download missing DxO Optics Modules**.
- **Export to disk**: Lets you process and then export images to a hard drive.
- **Export to Application**: Processes and then opens images in an application of your choice (a menu will prompt you to select the application).
- **Export to Facebook**: Lets you export images to your Facebook timeline.
- **Export to Flickr**: Lets you export images to your Flickr gallery.
- **Rotation**: Lets you rotate the image 90° to the left or right.
- **Ranking**: Allows you to rank images by quality using a star-rating system. Visible only if the “Ranking stars” option has been activated in Preferences.
- **Remove**: This command behaves differently depending on the situation:
  - In a project, the selected image will be removed from it [but not moved to the trash].
  - In a folder without virtual copies, the image is moved to the trash.
In a folder containing virtual copies which are all selected, moves all selected files to the trash.
- In a folder containing virtual copies which are not all selected, removes only the virtual copies (including from the associated projects).

**NOTE**
A message will inform you about the results of action to be taken.

- **Reveal original image in Finder**: Shows the location of the original image in the Finder.
- **Reveal corrected image in Finder**: Shows location of the corrected image in the Finder.
- **Rename on disk**: Lets you rename the selected image (you cannot perform batch renaming).
- **Fix image path**: If an image referenced in a project is missing, this command will let you search for it and re-add it to a project.
- **Create Virtual Copy**: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).
- **Create project from current selection**: Lets you create a new project from images you select in the Image Browser.
- **Add current selection to project**: Allows you to add images that you select in the Image Browser to an existing project.

**DxO Optics Modules menu**
This menu lets you handle the DxO Optics Modules required for fully automating your image processing:
- **Download missing DxO Optics Modules**: Connects you to the Internet so you can add new modules. These modules will be operational as soon as they have finished loading.
- **Manage DxO Optics Modules**: Displays all available DxO Optics Modules and lets you download the ones you select to your computer. Also lets you uninstall a DxO Optics Module that you have already downloaded (so long as it is not currently in use). You can filter the list to show only the list of DxO Optics Modules already installed on your computer by checking the “Show only installed DxO Optics Modules” box.
- **DxO Optics Modules Roadmap** (Internet connection required): Connects you to a page on the DxO Labs website containing a list of supported and planned DxO Optics Pro Modules (you can find the planned Modules in the list by clicking on the “Available” column header).
- **Suggest a DxO Optics Module to DxO Labs** (Internet connection required): Connects you to a form on the DxO Labs website in which you can suggest a DxO Optics Module for DxO Labs to produce.

**Window menu**
- **Minimize**: Collapses the application window into the OS X dock.
- **Zoom**: Fits the application main window (all panes) to the screen size.
- **Bring All to Front**: OS X command bringing all the application windows in front of other applications open at the same time.
- **Name of the folder / Project**: Shows the name of the current folder or Project.

**Help menu**
The Help menu contains several different sources of help and information about how to best use DxO Optics Pro.
- **DxO Optics Pro help**: Lets you consult integrated help topics.
- **Online help** (internet connection required): Opens Dxo online help.
- **DxO Academy** (internet connection required): Takes you to the home page of the DxO Academy, where you can find tutorials, webinars, and downloadable DxO software user guides.
- **Visit the DxO Labs web site** (internet connection required): Launches your default web browser and connects you to the home page on the DxO Labs website.

**NOTE**
However, in contrast to the Microsoft Windows version, there is no right-click function in the OS X version of the Viewer. You can right-click only on the thumbnails in the Image Browser to access this context menu.
7.2. Preferences

You can access the Preferences via the DxO Optics Pro 9 drop-down menu. The Preferences window is divided into five tabs.

General tab

- **On startup**: DxO Optics Pro automatically checks for updates upon launch.
- **Dialogs**: Automatically show the DxO Optics Module download window displays the DxO Optics Module download window if an image is discovered for which a DxO Optics Module is available, but has not yet been installed on your computer.
- **Presets**:
  - Default preset for new RAW images: Lets you select a default preset that will be applied to all RAW images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
  - Default preset for new RGB images: Lets you select a default preset which be applied to all RGB [JPEG, TIFF, DNG] images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
- **Statistics**: Indicates your willingness to participate or not in an anonymous product improvement program by DxO. This program sends a limited set of technical data about your system configuration and about your DxO projects to DxO Labs. To help DxO enhance its products and improve your experience. (Click on the Learn more link in the tab for more details.)

Display tab

- **Image background color**: Lets you pick the background color for the Viewer window in which your images are displayed.
- **Grid color**: Lets you pick the color of the Grid overlay tool and (if box is checked) display it in inverse video.
- **Grid size**: Sets the size of the grid cells.
- **Display tools in “Customize toolbar”**: Lets tools appear alongside the commands in the toolbar rather than in a separate palette.

Thumbnails tab

Icon display options:

- **Red/Orange/Green “lights”** indicate which images should or should not be processed.
- **Ranking stars** let you grade the quality of your images.
- **DxO Optics Module** icon indicates if a relevant DxO Optics Module is available or not.
- **Processing status** icon shows if an image is waiting to be processed, has been processed, is undergoing processing, etc.
- **Warning** icon is displayed when EXIF data is missing or imprecise or when any of the following corresponding warning options have been checked:
  - Focus defaulted to ∞ [infinity]
  - Focal length ambiguity
  - Orientation ambiguity
- **Delete** button (recycling bin icon) removes the current image from a project (when a project is open), delete a Virtual Copy or the source image (when a folder is open).

Process tab

- **Processed image extensions**: Allows you to change the extension for the three main categories of processed images (JPEGs, TIFFs, DNGs). This can allow you, in some rare cases, to transfer files to systems or applications which would need a three-digit extension (.jpg instead of .jpeg, for example).
- **Preserve metadata in XMP sidecars for RAW images**: Checking this box allows the application to process and export your RAW images while using metadata previously stored in an xmp-format file alongside the input image (e.g., metadata created by a program such as Adobe Bridge).
- **Use legacy (v2.0 and earlier) FilmPack color handling**: When activated, defaults the color handling to Filmpack 2 and earlier versions.
Advanced tab

Performance

- **GPU acceleration** lets you make use of the graphics card (GPU) to speed up the display. You should disable this control should be disabled if it causes your display to be unstable.

- **Disable noise reduction preview at zoom levels lower than 75%**: You can prevent DxO Optics Pro from displaying a preview of noise reduction when the zoom value is 75%. The preview is disabled by default (when activated, the responsiveness of the application can be reduced, depending on how powerful your computer is).

- **Batch processing power: minimum to maximum**: You can use the slider to set the amount of processing power you want your computer to use to process your images. Pushing the slider to the left allows other applications to work simultaneously with DxO Optics Pro processing, but makes the processing slower. Pushing it to the right accelerates the processing but to the detriment of other programs.

Sidecars

- **Automatically export sidecars** [checkbox]: Settings files (or sidecars) are small text files associated with an image whose names include the extension ".dop". They contain information for correcting images. If you want to transfer images to another computer using DxO Optics Pro, you can also transfer their sidecars settings. That way, when you add these images to your project (after checking that automatic loading is enabled on the other computer - see below), the corrections made on the original computer will show up on the destination computer. Note that you can also upload files to Settings via the **File > Sidecars > Import menu**.

- **Automatically import sidecars** [checkbox]: You can automatically include any existing sidecar information associated with image files that you download from another source.

Cache

**Maximum cache size**: Lets you set the size of the cache in order to improve overall performance. You can clear the cache by clicking on the adjacent Clear button.
8.1. Glossary

Calibration
Detailed measurements of cameras and lenses resulting in the thorough characterization of the lens- or camera-specific defects of images under given shooting conditions. DxO Optics Pro makes use of such data to provide custom-fitted corrections resulting in optimal image quality.

DxO Optics Module
A DxO Optics Module is a file that stores the calibration data of a given lens-camera combination, which allows DxO Optics Pro to automatically correct lens optical defects.

Full preset
A preset that contains all available correction settings, all of which have been assigned an activity status of either “activated” or “deactivated.”

Output image
The final image that DxO Optics Pro creates by applying the corrections listed in a preset to a source image. The output image is in all cases a new file with a different name from that of the source image.

Preset
A collection of predefined settings stored in DxO Optics Pro that can be applied on demand to any image. A preset can contain all available corrections (full preset) or only a fraction of them (partial preset). Users can manually fine-tune the settings for both full and partial presets, and can choose to save any adjustments to settings as a new custom preset.

Source or input image
Any RAW or JPEG image that enters the DxO Optics Pro processing workflow.

Virtual copy
A virtual copy is a duplicate of a source image associated with distinct settings. You can create a virtual copy to test two sets of corrections, one on the Source image itself, and the other on the virtual copy. You can create multiple virtual copies of the same source image, each with distinct settings, so as to compare the effects of different correction settings.
### 8.2. Keyboard shortcuts (Microsoft Windows)

#### General

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td>Paste (text fields)</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Undock/Dock Image Browser</td>
<td>Ctrl + U</td>
</tr>
<tr>
<td>DxO Optics Pro help</td>
<td>F1</td>
</tr>
<tr>
<td>Go to Organize tab</td>
<td>Ctrl + F1</td>
</tr>
<tr>
<td>Go to Customize tab</td>
<td>Ctrl + F2</td>
</tr>
<tr>
<td>Open Preferences</td>
<td>Ctrl + Shift + P</td>
</tr>
<tr>
<td>Display reference image (hold down key)</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>Full-screen mode</td>
<td>Alt + F</td>
</tr>
<tr>
<td>Display/Hide Image Browser</td>
<td>Ctrl + F9</td>
</tr>
<tr>
<td>Refresh Image Browser</td>
<td>F5</td>
</tr>
<tr>
<td>Rename folder/file/project/preset</td>
<td>F2</td>
</tr>
<tr>
<td>Project properties</td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>Adjust screen size</td>
<td>F3</td>
</tr>
<tr>
<td>Zoom to 100 %</td>
<td>F4</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + –</td>
</tr>
<tr>
<td>Temporary activation of Hand tool (hold down key)</td>
<td>Space bar</td>
</tr>
<tr>
<td>Go to preceding image</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Go to next image</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Rotate image 90° to the left</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Rotate image 90° to the right</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Create a virtual copy</td>
<td>Ctrl + J</td>
</tr>
<tr>
<td>Rank image (number of stars)</td>
<td>Ctrl + 0 to 5</td>
</tr>
<tr>
<td>Launch export of selected images</td>
<td>Ctrl + Alt + P</td>
</tr>
<tr>
<td>Image properties</td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Remove image from project</td>
<td>Delete</td>
</tr>
<tr>
<td>Delete image from disk</td>
<td>Delete</td>
</tr>
<tr>
<td>Delete virtual copy</td>
<td>Delete</td>
</tr>
<tr>
<td>Print selected images</td>
<td>Ctrl + P</td>
</tr>
</tbody>
</table>

#### Organize tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display/Hide Source Browser</td>
<td>Ctrl + F9</td>
</tr>
<tr>
<td>Display hard drive folders</td>
<td>Shift + F9</td>
</tr>
<tr>
<td>Display projects</td>
<td>Shift + F10</td>
</tr>
</tbody>
</table>

#### Customize tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display reference and corrected images side-by-side or in front/behind</td>
<td>Ctrl + T</td>
</tr>
<tr>
<td>Display/Hide all palettes</td>
<td>F9</td>
</tr>
<tr>
<td>Fit to screen</td>
<td>F2</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>F3</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
</tr>
<tr>
<td>Display/Hide grid</td>
<td>Ctrl + G</td>
</tr>
<tr>
<td>Display/Hide information overlay</td>
<td>Ctrl + H</td>
</tr>
<tr>
<td>Display clipped highlights</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Display clipped shadows</td>
<td>Ctrl + B</td>
</tr>
<tr>
<td>Copy / Paste correction settings</td>
<td>Ctrl + Shift + C / V</td>
</tr>
</tbody>
</table>

**Tools**

Move active slider (click to activate): Left and right arrows, mouse wheel, or trackpad scrolling

---

### 8.3. Keyboard shortcuts (OS X)

#### General

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Cmd + N</td>
</tr>
<tr>
<td>Open project</td>
<td>Cmd + O</td>
</tr>
<tr>
<td>Save project</td>
<td>Cmd + S</td>
</tr>
<tr>
<td>Quit DxO Optics Pro</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>Cut (text fields)</td>
<td>Cmd + X</td>
</tr>
<tr>
<td>Copy (text fields)</td>
<td>Cmd + C</td>
</tr>
<tr>
<td>Paste (text fields)</td>
<td>Cmd + V</td>
</tr>
<tr>
<td>Select all</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Undo</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Cmd + Shift + Z</td>
</tr>
<tr>
<td>Undock/Dock Image Browser</td>
<td>Cmd + U</td>
</tr>
<tr>
<td>Help</td>
<td>Cmd + ?</td>
</tr>
<tr>
<td>Go to Organize tab</td>
<td>Alt + Cmd + 1</td>
</tr>
<tr>
<td>Go to Customize tab</td>
<td>Alt + Cmd + 2</td>
</tr>
<tr>
<td>Open Preferences</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Display/Hide Image Browser</td>
<td>Cmd + Tab</td>
</tr>
<tr>
<td>Go to next tab</td>
<td>Ctrl + Tab</td>
</tr>
<tr>
<td>Go to preceding tab</td>
<td>Ctrl + Shift + Tab</td>
</tr>
<tr>
<td>Print selected images</td>
<td>Cmd + P</td>
</tr>
</tbody>
</table>

#### Customize tab

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display reference image</td>
<td>D</td>
</tr>
<tr>
<td>Hand tool</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Display reference and corrected images side-by-side or in front/behind</td>
<td>C</td>
</tr>
<tr>
<td>Display/Hide all palettes</td>
<td>Tab</td>
</tr>
<tr>
<td>Fit display to screen</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom at 100%</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Cmd + = or +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
</tr>
<tr>
<td>Display/Hide grid</td>
<td>G</td>
</tr>
<tr>
<td>Display/Hide information overlay</td>
<td>I</td>
</tr>
<tr>
<td>Display clipped highlights</td>
<td>A</td>
</tr>
<tr>
<td>Display clipped shadows</td>
<td>B</td>
</tr>
<tr>
<td>Create virtual copy</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>Tool</td>
<td>shortcut</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Hand (hold down key)</td>
<td>J</td>
</tr>
<tr>
<td>Arrow</td>
<td>J</td>
</tr>
<tr>
<td>Move/Zoom</td>
<td>Y</td>
</tr>
<tr>
<td>Crop</td>
<td>R</td>
</tr>
<tr>
<td>Dust</td>
<td>N</td>
</tr>
<tr>
<td>Horizon</td>
<td>E</td>
</tr>
<tr>
<td>Force parallels</td>
<td>U</td>
</tr>
<tr>
<td>Rectangle</td>
<td>V</td>
</tr>
<tr>
<td>Multi-Point Color Balance</td>
<td>*</td>
</tr>
<tr>
<td>White balance</td>
<td>W</td>
</tr>
</tbody>
</table>